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ABSTRACT  
   

This combined research provides in-depth insights into both the tectonic evolution of the 

Bradshaw Mountain region in Arizona and the effective use of Structure-from-Motion (SfM) 

photogrammetry in remote geological education.  

The first study focuses on deciphering paleostress fields in the Bradshaw Mountains 

region, which helps unravel Earth's past tectonic activities and lithospheric evolution. By 

examining fractures in plutonic stocks, ranging in age from 73 to 64 million years, crucial insights 

into the area's tectonic history were obtained. Fracture properties such as size, frequency, 

orientation, and location were diligently recorded. Further examination in a regional context 

revealed a complex stress regime during the Laramide orogeny, underpinned by diverse fracture 

and aplite dike orientations. The findings hint at potential influences of stress reversal during 

Laramide pluton emplacement and crystallization on regional principal stress, which deviated 

from previous regional tectonic studies. Factors like crustal dilation, local uplift, tensile stress 

cycle, and topographic stress could explain the lack of predicted mineralized orientations. The 

implications of these findings are vital for reconstructing Laramide tectonic and magmatic 

activities in the region, although further research is required to fully understand the causative 

mechanisms.  

The second study centers on the use of SfM photogrammetry in geological education, 

with a focus on remote learning environments. This involves creating 3D models of hand samples 

and outcrops with exceptional resolution for detail recognition. Detailed guidance on hardware 

and software specifications, image capture conditions, file management, and 3D model creation 

using Metashape is provided. The study emphasizes the dual-masking technique for optimum 

texture quality and the role of SketchFab in the analysis and viewing of the final product. This 

integration of SfM photogrammetry into geological education supplements traditional hands-on 

learning and enhances students' grasp of geological concepts. The technique provides an 

immersive, interactive experience, especially beneficial for students unable to physically access 

geological samples, and fosters critical thinking through a hands-on digital interface.  
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CHAPTER 1 

INTRODUCTION 

 

Background 

The study of paleostress fields is crucial for reconstructing the tectonic history of a region 

and gaining insight into the evolution of Earth's lithosphere. Paleostress fields are a record of the 

stress that acted on rocks in the past, and they provide valuable information about the orientation, 

magnitude, and temporal evolution of tectonic forces. By studying the distribution and orientation 

of structures in rocks, geologists can determine the paleostress field and understand how it has 

changed over time. 

Paleostress information is a key to better understanding the underlying mechanisms of 

tectonic activity, including constraining unknowns such as plate-boundary interactions and 

mountain formation. For example, the orientation of fractures and other structures in rocks can 

help us infer the direction of plate convergence or divergence, and the magnitude of stress can 

provide insight into the strength of tectonic or gravitational forces. Constraining paleostress fields 

is an essential pursuit as we try to reconstruct the geologic past and model the tectonic history of 

a specific region. 

Furthermore, paleostress fields can also help to determine the timing and extent of 

mineralization events. The distribution and orientation of mineral deposits have been shown to 

often be controlled by the paleostress field, and by reconstructing the stress history of a region, 

geologists can determine the conditions under which mineralization occurred and the likely 

orientations of mineralized fractures and veins. This information is important for both mineral 

exploration and resource management. In summary, understanding paleostress fields provides 

valuable information about the tectonic history, tectonic processes, and mineral potential of a 

region, making it an essential aspect of structural geology. 
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Location 

The study area for this thesis is within the Bradshaw Mountain region (Figure 1) of central 

Arizona. It is located in the Transition Zone Province of Arizona of the southwestern United 

States. This approximately 2,400 km 2 region is characterized as having both rugged terrain and 

diverse geology. The Bradshaw Mountains themselves are characterized by a series of 

mountains, ridges, and valleys, with widely ranging elevations (467 to 2,134 meters). The region’s 

climate is characterized by semi-arid conditions, with a low average yearly precipitation (250 to 

500 millimeters), and an average temperature ranging from 10 to 20°C. This climate influences 

the vegetation, which is a combination of Sonoran Desert scrub and pinyon-juniper woodlands. 

 

Purpose 

The reconstruction of paleostress fields is a crucial aspect of geological research, 

providing insights into past tectonic activity and the evolution of geological structures. Despite the 

challenges and ambiguities associated with determining paleostress fields, numerous studies 

have shown that regional fracturing patterns in plutonic rocks can provide useful information for 

constructing a paleostress regime. Rehrig and Heidrick (1972) were among the first to 

demonstrate this, and since then, the study of fracture characterization, categorization, and 

orientation has been widely recognized for its significance in a variety of fields, including 

engineering, safety, hydrology, and economics (Best, 1988). 

This thesis focuses specifically on the determination of the paleostress field in the 

Bradshaw Mountain region of Arizona during the Laramide orogeny, which is commonly 

considered as occurring between 80 and 40 Ma and being related to plate convergence along the 

Pacific coast. The stress field during this time has been studied in the Basin and Range Province 

(Rehrig and Heidrick, 1972) and on the Colorado Plateau (Davis, 1991), but not much has been 

written about Laramide stresses of the Transition Zone. Here, I utilize the analysis of regional 

fractures in five plutonic stocks. I conducted a comprehensive investigation of fracture 

orientations, hydrothermal mineralization, and resultant alteration on the Laramide age (74-64 

Ma) plutonic stocks in the study area (figure 1). The study aims to not only provide an 
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interpretation of the regional paleostress regime at the time of emplacement but also speculate at 

the mechanisms that played a role in shaping it. The results of the study are expected to 

contribute to the broader understanding of the geological evolution of the Bradshaw Mountain 

region.  

Figure 1- Study Area: (Left) A map showing the significant Laramide age plutonic stocks located 
in Arizona. The blue circle highlights the region being studied. (Right) A detailed view of the five 
plutonic stocks of Laramide age that are situated in the Bradshaw Mountains region. The five 
stocks are Pine Flat, Crown King, Copper Basin, Ticonderoga, and Walker. 
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CHAPTER 2 

LITERATURE REVIEW 

 

Previous Studies 

A comprehensive overview of the history and work done in this region is beyond the 

scope of this work, however, a summary of key contributors is provided below: 

The pioneering work of Jaggar and Palache (1905) set the foundation for the first 

geological description of rock units in the region. This was followed by Lindgren's (1926) classic 

report on the history of mines and the examination of future mineral prospects in the region. 

Subsequently, Anderson and Creasey (1958) advanced the work of Lindgren, incorporating a 

thorough review of previous studies and research, to provide a comprehensive description of the 

geology and ore deposits of the area. While Henderson (1958) and Dunning (1966) focused on 

the anthropologic history of the people and mining in the region, Blacet (1968) mapped and 

described the geology of the Mount Union quadrangle, which was later revised by Anderson and 

Blacet (1972). DeWitt (1976) also made a significant contribution by mapping the geology and 

describing the ore bodies in the Mayer-Crown King area, and later producing a geological map of 

the entire Prescott National Forest (DeWitt et al, 2008). For a comprehensive understanding of 

the rich geological history and evolution of thought on the Bradshaw Mountains region, readers 

are encouraged to refer to the works of these authors. 

The significance of fractures to alteration and mineralization has been recognized for 

over a century. As a result, the origin of fractures in and around plutons has been the subject of 

numerous studies. Thermal stresses during pluton cooling, magma pressure, and stress 

associated with regional tectonics have been proposed as important or dominant factors in the 

origin of fractures (Gerla, 1983). 

Several authors have completed detailed graduate level studies on the structure and 

petrology of the Laramide stocks in the study area, including Copper Basin (Johnston and Lowell, 

1961), Pine Flat area (Spatz, 1995), Ticonderoga district (Sturdevant, 1975), and Crown King 

(Ball, 1982). While each of these works are independently noteworthy, none of them focus 
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specifically on the regional stress regime during the emplacement of the plutons. However, Balla 

(1972) suggested that the emplacement of Laramide stocks in Central Arizona was largely 

influenced by preexisting Proterozoic structures.
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CHAPTER 3 

REGIONAL GEOLOGIC AND TECTONIC SETTING 

The geology of the Bradshaw Mountains region is complex and diverse. Rock units in the 

area are primarily comprised of Proterozoic gneisses, both metavolcanic and metasedimentary, 

and granites. Though locally preserved Paleozoic sedimentary rocks, Laramide plutons, and 

Cenozoic volcanic and sedimentary rocks are common (DeWitt et al, 2008). The older 

Proterozoic rocks have undergone multiple stages of deformation, including the Yavapai orogeny, 

the compressive Laramide orogeny, and Cenozoic crustal extension. These tectonic events have 

left complex geological structures which are readily observed, including folds, faults, and 

intrusions. The region is also known for its mineral resources, including gold, silver, copper, and 

molybdenum, which have been extracted from hundreds of mines in the area (Lindgren, 1926; 

Clements, 1991; O’Hara et al, 1991). 

The Laramide orogeny (80-40 million years ago) was a significant tectonic event and its 

effects in the Southwest are interpreted as a consequence of subduction of the Farallon Plate 

beneath the North American Plate, in some places at a very low angle (Coney and Reynolds, 

1977; Dickinson and Snyder, 1978). This interaction between the two plates resulted in the uplift 

and deformation of the overlying North American Plate and had a profound impact on the 

geological evolution of the southwestern United States. The study of the Laramide orogeny and 

the associated plutonic stocks in the Bradshaw Mountain region provides a window into the 

area’s tectonic evolution and allows for better understanding of the processes that shaped it. 

Processes such as the subduction of the Farallon Plate, magma emplacement, and the resulting 

tectonic uplift all could be better constrained in time and space. Insights into these processes are 

essential for reconstructing the paleotectonic history of the southwestern United States and 

inform future geological investigations in the area. 

Plutonic stocks are large, intrusive igneous bodies that formed in the upper crust as a 

result of magma emplacement. Laramide plutonic stocks are unique in their geological 

characteristics, such as geochemistry, mineralogy, and textural features, and provide information 

about the conditions under which they formed, including the depth and temperature of 
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emplacement, magma composition, and tectonic setting (Lang, 1991). The magmatic arc that 

characterized the Laramide was produced by subduction of the Farallon plate and is best known 

for calc-alkaline intrusive rocks (Dickinson, 1988). The arc formed between 80 and 50 million 

years ago, becoming more felsic over time, as it transitioned from relatively mafic to more felsic 

magma compositions (Lang, 1991).  

The Bradshaw Mountain area provides a good opportunity to conduct this study because 

it is accessible, fractures are well displayed, and there is good evidence that fracturing, 

hydrothermal alteration, and deposition of copper sulfides are nearly contemporary with the 

crystallization of Laramide stocks (Studevant, 1975; Norton, 1982). 

In this study, I investigated five different Laramide stocks, two of which are interpreted to 

be related and are discussed together. These include (1) Pine Flat stock, (2) Crown King stock, 

(3) Copper Basin stock, and (4) Ticonderoga and Walker stocks. 

 

Pine Flat Stock 

Figure 2- Anomalous subdued topography and vegetation with the Pine Flat boundaries 
superimposed on areal imagery with a subset of regional geology taken from DeWitt et al (2008). 
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The Pine Flat stock is situated within the Paleoproterozoic Spud Mountain Volcanics, 

which are comprised of intermingled andesitic and rhyolitic pyroclastic flows and breccias. The 

lower sub-unit of the Spud Mountain Volcanics, a massive quartz-albite tuff, is the principal unit 

that the Pine Flat intrusion intrudes upon at the surface (Anderson and Blacet, 1972). The 

surrounding Proterozoic units exhibit foliation and folding. 

Pine Flat is aptly named as the boundary can be effectively defined by its subdued 

topography and pine coverage (Figure 2). This boundary displays an elongated east-west axis, 

which is distinct as it does not align with the NNE-SSW foliation trend of the Proterozoic units; 

instead it is nearly orthogonal to it. Outcrops of the Pine Flat stock are typically friable and coated 

in a thin layer of limonite alteration (Figure 3).    

Pine Flat is described by Spatz (1995) as a light gray quartz latite porphyry with variable 

phenocryst size and density, ranging from 20-40% subhedral plagioclase feldspar (1-5 mm), 5-

10% euhedral biotite hexagonal books (1-3 mm), 0-5% subhedral hornblende (1-3 mm), and 0-

10% anhedral rounded quartz (1-5 mm). The matrix is mainly composed of quartz and orthoclase 

feldspar, with accessory apatite and 

magnetite. Spatz also observed a 

decrease in the orthoclase to plagioclase 

ratio from the center of the stock. 

Throughout the intrusion are equigranular 

aplite dikes, consisting of subhedral quartz 

and alkali feldspar (~0.1 mm) with widths 

ranging from 1-15 cm, and up to 40 cm in 

some cases. These aplite dikes tend to 

follow major joint sets.  

 

Figure 3- Typical coloration and coating on joint 
surfaces. 
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Crown King Stock 

The Crown King stock is situated 

within the central Bradshaw Mountains 

region and forms a roughly oval-shaped 

erosional basin (figure 4) within the 

Proterozoic rock formations it intrudes, 

namely the Yavapai Series and the Crazy 

Basin and Brady Butte plutons (Jagger 

and Palache, 1905; DeWitt et al, 2008). 

The Yavapai Series is situated within the 

central Arizona volcanic belt and has 

undergone regional deformation, resulting 

in the formation of isoclinal folds. 

Figure 4- Erosional basin of the Crown King stock superimposed on areal imagery with a subset 
of regional geology taken from DeWitt et al (2008). 

Figure 5- Representative of Crown King 
granodiorite. Fracture shows alteration selvage. 
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The Crown King granodiorite is described by Ball (1982) as fine-to-coarse grained with 

abundant hornblende and rare plagioclase phenocrysts (figure 5). It is typically holocrystalline, 

phaneritic, and medium to fine-grained, with a hypidiomorphic granular texture. Oligoclase 

phenocrysts, which are euhedral to subhedral in shape, are the dominant feature in the rock and 

exhibit oscillatory and normal zoning, with albite twining present in all samples. Additionally, rare 

quartz and orthoclase phenocrysts, as well as anhedral quartz, orthoclase, and microcline grains, 

are locally present in the rock's groundmass. The Crown King granodiorite weathers to form 

sandy soil and large, spherical outcrops with evenly spaced joints. Breccia pipes, which contain 

varying amounts of copper and molybdenum mineralization, are the only exception to the uniform, 

mostly unaltered nature of the granodiorite in the outcrop area. 

 

Copper Basin Stock 

The Copper Basin is an oval-shaped depression that has been formed by differential 

erosion, with the more resistant Proterozoic igneous and metamorphic rocks eroding less than 

Figure 6- Oblique view of the erosional basin formed by the Copper Basin stock superimposed on 
areal imagery with a subset of regional geology taken from DeWitt et al (2008). 
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the intrusive stock of Laramide age 

(Figure 6). Johnston and Lowell (1961) 

described a series of intrusions, the 

largest of which is a quartz monzonite 

(Figure 7), which covers the central floor 

of the basin. This rock is less resistant to 

weathering compared to other igneous 

rocks in the area, and is mostly covered 

by residual soil and terrace gravels along 

and east of Copper Basin Wash. The 

quartz monzonite is believed to comprise 

multiple intrusions and is primarily made 

up of andesine, orthoclase, quartz, biotite, 

and locally hornblende, with minor 

accessory minerals including apatite, 

zircon, and iron ores. 

Christman (1978) describes the 

eastern margin of the Copper Basin deposit as a border facies ranging from granodiorite to 

meladiorite. These facies are abundant along the outer margins of the Copper Basin stock and 

were the earliest Laramide rocks to crystallize when the Copper Basin stock intruded the cooler 

Proterozoic wall rocks; they are medium gray to nearly black with plagioclase, quartz, biotite, and 

actinolitic hornblende. Clinopyroxene rimmed by hornblende is locally present in the meladiorite, 

and anhedral quartz and orthoclase are interstitial to the plagioclase. Magnetite makes up to 12% 

of the border facies rocks. 

 

Figure 7- Mineralized fractures within typical quartz 
monzonite. 
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Ticonderoga and Walker Stocks 

The Walker and Ticonderoga intrusions are significant Laramide geological features in 

the area (figure 8). These two structures are positioned near each other, with Walker situated to 

the west and Ticonderoga to the east. The pre-existing Proterozoic structures like the Chaparral 

high-strain zone, and stress-induced fracturing during the Laramide orogeny likely influenced the 

intrusion of these Laramide stocks. The mineralogy and texture of the plutons are similar and may 

be linked at a deeper level (Anderson and Blacet, 1972). Both intrusions are primarily oriented in 

an elongate NNE-SSW alignment, with smaller E-W bodies between them further demonstrating 

their close association (O'Hara et al, 1991). 

Sturdevant (1975) described the lithology of the Ticonderoga stock as mainly medium-

grained biotite tonalite and granodiorite. The northern phase is more granodioritic and weathers 

to yellow-brown due to weathering that destroys ferromagnesian minerals. On the other hand, the 

southern phase is tonalitic, has more variable amounts of quartz and orthoclase, and it is 

commonly altered by hydrothermal propylitic alteration. The border phase is typically dioritic in 

Figure 8- Ticonderoga (right) and Walker (left) stocks superimposed on areal imagery with a 
subset of regional geology taken from DeWitt et al (2008). 
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composition and composed of plagioclase and potassium feldspar phenocrysts in a groundmass 

of finely crystalline microscopic quartz and potassium feldspar, and ferromagnesian minerals like 

chlorite and pale brown biotite. The rock is also altered to silicates and contains accessory 

minerals such as magnetite, sphene, zircon, and apatite. In the Walker stock, field observations 

were consistent in zones of all three phases in the Ticonderoga stock and were considered 

analogous (figure 9). 

 

 

Figure 9- (Left) Granodioritic fractured outcrop in the Walker stock. (Right) Tonalitic fractured 
outcrop in the Ticonderoga stock. 
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CHAPTER 4 

METHODS 

The use of fractures within plutonic bodies as indicators of stress fields has been widely 

researched, with Rehrig and Heidrick (1972) being among the pioneers in this field. They showed 

that the systematic pattern of fractures in the Basin and Range Province of Arizona was 

convincingly indicative of regional tectonic control. They elected to use non-productive stocks and 

porphyry copper orebodies because they offer a robust record of regional structures due to their 

relatively isotropic nature and the absence of pre-existing stress effects. Their findings were 

supported by subsequent studies by Rehrig and Heidrick (1976) and Heidrick and Titley (1982) 

using larger data sets. Further confirmation for the use of fractures as key indicators has been 

provided by several detailed and localized studies (e.g., Gerla, 1983, 1988; Titley et al., 1986; 

Fitzpatrick, 2021). 

In this study, a comprehensive analysis of fractures and dikes was conducted on five 

non-productive stocks. The plutons studied range in age from 73 to 64 million years (DeWitt et al., 

2008), with the exception of the Pine Flat stock, which is only inferred to be of Laramide age 

(Spatz, 1995). Based upon the work of Norton (1982), which suggests that the majority of 

mineralized fractures form in the first 100 to 200 ka after pluton emplacement, we gain a clear 

temporal framework for our investigation that is restricted to the Laramide magmatic pulse.  

The methodology used was based on the techniques described by Heidrick and Titley 

(1982). Representative data on the size, frequency, orientation, and location of fractures, veins, 

and dikes (figure 10) were gathered across multiple locations within each pluton (figures 11-15) to 

ensure a comprehensive understanding of the features present. The fractures were then 

classified into sets, and the presence or absence of mineralization within each fracture was 

recorded. Dozens of orientation data were taken at each location for each set and a 

representative attitude for each set was recorded. Fracture orientation was meticulously recorded 

along each transect, using conventional azimuthal notation and right-hand rule, with abundant 

fractures readily observed in each stock. The planar features were divided into six categories: dry 
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fractures (simple joints), altered fractures, mineralized fractures, closely spaced micro fractures, 

veins, and aplite dikes.  

Dry fractures are simple joints that show no signs of alteration or mineralization; they are 

exactly as named. Altered fractures are fractures that have undergone changes in their 

mineralogy due to interaction with chemically active fluids that flowed through the fractures. 

Mineralized fractures are fractures that have been filled with minerals precipitated from 

hydrothermal fluids. Closely spaced microfractures are small-scale fractures that are similarly 

oriented and separated by a distance on the order of millimeters. These microfractures are 

typically associated with thermal stress and fluid pressure and are not commonly encountered in 

the field. Veins, for the purpose of this study, are defined as larger (centimeter to meter scale) 

planar features typically filled with quartz and are not commonly encountered. Aplite dikes are 

primarily feldspar and quartz planar or tabular dikes that represent the final stages of solidification 

in a cooling magma chamber. Fractures filled with aplite give a time constraint for the final 

fractures to be filled at the time of emplacement of the magma chamber. 

The orientation of fractures interpreted as joints was determined by taking multiple strike 

and dip readings at a given location on discrete joints and then a representative orientation for 

each set at that location was selected. The recognition of alteration and its mineralogies was 

critical to the field work and interpretations made in this study therefor, any mineralization present 

on the joints was also documented, with field interpretations assigned for minerals such as 

epidote, magnetite, and quartz frequently encountered. Vein and dike information were also 

recorded individually where encountered along each traverse. 

To ensure accuracy, the study was based on the map created by DeWitt et al. (2008), 

which typically agreed with the observations made during the data collection. As a result, no 

further efforts were made to remap the plutonic stocks. The geological units and their contacts 

were adopted directly from the map and remain unchanged, except for data collection locations 

superimposed. 
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Figure 10- Diagrams displaying common fracture types and styles encountered during mapping. 
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CHAPTER 5 

DATA COLLECTION 

Locations 

Figure 11- Pine Flat fracture orientation data collection sites. Each dot represents the beginning 
of a transect. Map units taken from DeWitt (2008) and superimposed on topographic map. 
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Figure 12- Crown King fracture orientation data collection sites. Each dot represents the 
beginning of a transect. Map units taken from DeWitt (2008) and superimposed on topographic 
map. 
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Figure 1- Copper Basin fracture orientation data collection sites. Each dot represents the 
beginning of a transect. Map units taken from DeWitt (2008) and superimposed on topographic 
map. 
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Figure 2- Walker Stock fracture orientation data collection sites. Each dot represents the 
beginning of a transect. Map units taken from DeWitt (2008) and superimposed on topographic 
map. 
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Figure15- Ticonderoga stock fracture orientation data collection sites. Each dot represents the 
beginning of a transect. Map units taken from DeWitt (2008) and superimposed on topographic 
map. 
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Mineralized Fractures and Aplite Dikes 
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Figure 16- Rose diagrams and Kamb contours in standard deviations for mineralized fractures 
and aplite dikes in each Bradshaw Mountains region stock. Bottom diagram contains orientations 
for each stock combined. 
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The data (figure 16) indicate either the absence of a preferential orientation or the 

presence of a radial pattern in the orientation of mineralized fractures in each of the stocks 

analyzed. While a significant NE-SW trending fracture set was observed in many of the stocks, 

possibly indicative of regional Laramide compression, all stocks also included a set trending E-W 

to WNW-ESE. The fractures were nearly vertical in orientation. Most of the mineralized fractures, 

veins, and aplite dikes exhibited little to no structural offset and were not typically deformed, 

suggesting a dominantly tensional origin. 

For the Walker and Ticonderoga stocks, O’Hara et al (1991) noted an E-W distribution of 

gold, silver, and base-metal analyses, even though some veins and the Walker pluton are 

oriented NE-SW. This is consistent with the current study, which shows a lack of a dominant 

northeast control of fractures. 
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CHAPTER 6 

SUMMARY AND CONCLUSIONS 

Based on the lack of a dominant fracture direction, the Bradshaw Mountain region 

experienced a weak, but complex stress regime during the Laramide orogeny, likely resulting 

from the interaction between regional and local forces. This complexity is evidenced by the 

diverse variety of mineralized fracture and aplite dike orientations that are present in the area.  

According to Rehrig and Heidrick (1972), there was a dominant NE-SW orientation and a 

secondary NNW orientation of mineralized fractures and dikes in specific Laramide plutons in 

Arizona. These orientations are believed to have arisen from northeast-directed horizontal 

compression during the Laramide period, leading to a NE-SW set of fractures, and differential 

uplift, resulting in a NNW set of fractures. Recent palinspastic reconstructions have indicated that 

the Laramide period was marked by NE to E-W directed shortening after removing the effects of 

overprinted Cenozoic extension (Favorito, 2020).  

During the early stages of the Laramide orogeny, tectonism and magmatism in the 

southwestern United States were influenced by the east-northeast-directed subduction of the 

Farallon plate beneath the North American plate, resulting in a dominant regional stress of 

maximum compression oriented east-northeast and differential uplift along north-northwest to 

northwest elongate arches. 

 Davis (1981) suggested that during the Laramide period, there was a NE-directed 

shortening episode, based on the predominant N50°E orientation of compressional lineations. 

Recent palinspastic reconstructions, after removing the effects of overprinted Cenozoic 

extension, have indicated that the Laramide period was marked by NE to E-W directed shortening 

(Favorito, 2020). 

The results of this study suggest that the NE-SW Laramide stress pattern was less 

dominant in the Bradshaw Mountains region than elsewhere. The direction of regional principal 

stress was probably overwhelmed by local or subregional forces. A weakening of regional stress 

during the emplacement and crystallization of the Laramide plutons may also be inferred. This 

discrepancy may be explained by outer arc stretching in an uplift with a  north-northwest axis 
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through the intrusion, which caused a significant decrease in the magnitude of regional stress 

oriented east-northeast. 

In 1982, Heidrick and Titley explored the porphyry systems of the southwestern United 

States and proposed that plutons serve as a source of energy for stress necessary for failure. 

They argued that the interplay of thermal stress, magma pressure, and regional tectonics results 

in a structural pattern centered around the pluton. Their findings indicated that the dominant origin 

of stress and fractures in the stocks studied was a result of thermal, magmatic, and gravitational 

forces associated with the emplacement and crystallization of the pluton, which were then 

modified by regional tectonic activity. If the effects of this regional tectonic activity are weak or 

negated, then the thermal, magmatic, and gravitational forces will dominate the fracture openings.  

 

Possible Explanations 

The current study has observed differences in regional tectonic stress orientations 

compared to other previous studies, studies which have undergone multiple independent 

replications. The reasons for these differences are not yet clear.  

The Ticonderoga (Big Bug) intrusion, located in Ticonderoga, was identified by Rehrig 

and Heidrick (1972) as being an exception to the regionally consistent NE-SW-compressional 

stress pattern. The Granite Wash intrusion, located in west-central Arizona, also exhibited similar 

characteristics. Rehrig and Heidrick report that “The Cornelia, Big Bug, and Granite Wash 

intrusions are characterized by the presence of well-developed mineralized WNW joint sets. The 

less well-defined NNW to NW fractures in the Big Bug, Granite Wash, and Schultze stocks 

occasionally exhibit mineralization.“ Rehrig and Heidrick identified the less ordered stress pattern 

documented by my study for other plutons in the region. 

Several mechanisms may have individually or collectively contributed to varying degrees 

to the lack of preferential mineralized orientations predicted by the regional tectonic stress field. 

Assessing the relative contribution of each mechanism is beyond the scope of this project, but I 

summarize some possible factors below.  
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Crustal Dilation: The phenomenon of crustal dilation involves an increase in the volume 

of some part of the Earth's crust. This expansion can result in the formation of multiple sets of 

mineralized fractures, as the increased volume creates tensile stress in the rock, leading to 

cracking. Davis (1981) posits that the presence of modest (5%) crustal dilation in both an ENE 

and NNW direction in the plutons accommodated more than one set of mineralized fractures. 

However, this mechanism may only account for a secondary set of mineralized fractures and not 

the disordered orientations observed in the study. 

Local uplift: Local uplift can cause changes in the stress state of a pluton that can result 

in the formation of mineralized fractures that are not aligned with the regional stress field. This is 

because local uplift creates new, localized stress orientations that dominate over the regional 

stress field. The localized stress concentrations become more influential in controlling the 

formation and orientation of mineralized fractures compared to the regional stress field. 

Additionally, local uplift can also alter 

the distribution and orientation of fluids 

within the rock, which can further 

impact the formation and orientation of 

mineralized fractures. The Bradshaw 

Mountains were part of a regional uplift 

during Laramide time, an uplift that 

contributed clastic material to streams 

that drained the area and flowed onto 

the Colorado Plateau (Potochnik et al, 

2022). Such uplift could have caused 

stresses that overprinted the regional 

stress field. 

For example, Gerla (1983) 

demonstrated in the Diamond Joe 

stock, which is geographically and 

Figure 3- Depiction of local uplift changing the direction 
of maximum principal stress. Taken from Gerla (1983). 
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chronologically similar to the five stocks examined in this study experienced such an affect. 

During the inflation of a chamber and the uplift of the basement, the least principal stress is 

vertical. As the pluton solidifies, the fracturing is primarily controlled by regional, magmatic, and 

thermal stresses. A dominant radial and concentric fracture pattern is expected (Titley et al, 

1986). Uplift of the basement is likely concurrent with the intrusion of magma and can cause local 

shallow crustal stresses to develop. Resulting in a decrease in stress perpendicular to the axis of 

uplift and a reversal of the maximum and minimum principal stress directions (Figure 17). This 

change in the direction of maximum principal stress during the formation and cracking of a pluton 

could have similarly affected Laramide plutons in the Bradshaw Mountains area. 

Tensile Stress Cycle: A tensile stress cycle is a repeated pattern of stress buildup and 

release in response to the combined effects of fluid pressure and/or stress release during uplift 

and erosion. Each time this fracturing occurs can cause a temporary flip in the stress field and 

result in a change in the orientation of the fractures. The cycle of tensile stress buildup and 

release can repeat multiple times as the conditions promoting the formation of tensional fractures 

persist (Fitzpatrick, 2021). This process may play a significant role in the structural evolution of 

plutonic intrusions, and their having multiple mineralized fracture sets, such as is observed in the 

Bradshaw Mountains region. 

Topographic stress: Topographic stress is a phenomenon that arises due to uneven 

pressure distribution on the Earth's surface, and its effects on geological processes are widely 

recognized, particularly in relation to crustal overthickening. Considerable research has been 

conducted to study the dynamics and implications of topography on stress distribution (Liu & 

Zoback, 1992; Miller & Dunne, 1996; Bump, 2004), revealing that the highest compressive stress 

in a topographic high is typically horizontally oriented and perpendicular to its trend. The 

Bradshaw Mountains area was part of a northwest-trending uplift, and this could have led to NE-

SW tensional forces that overwhelmed or influenced the regional stress pattern. 

The Andean region presents a modern analogue, where the southern edge of the 

Altiplano-Puna plateau generates a southeast-directed stress that is different from the northeast-

directed regional tectonic stress field. The Sierras Pampeanas of Chile and Argentina have an 
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abnormally thick crust and are comparable 

to the Laramide Province in Arizona 

(Jordan and Almendinger, 1986). Although 

there was some minor crustal shortening 

caused by flat-slab subduction, it was not 

enough to explain the thickness of the 

crust. It's possible that older tectonic 

events, such as the Maria Fold and Thrust 

Belt and Sevier orogenies, thickened the 

crust before the Laramide and should be 

considered in addition to the syn-Laramide 

crustal overthickening (Salem, 2009).  

Surprisingly, current stress field 

modeling suggests that the stress caused 

by the Andean topography is likely greater than the regional tectonic stress (Assumpcao and 

Araujo, 1993). If studies such as those conducted by Chapman et al (2020) (Figure 18) and 

Chang and Liu (2020) are correct and the Laramide orogeny produced topographic highs of 

comparable or greater magnitude, then topographically induced stresses could have 

overwhelmed the regional tectonic stress field in the Bradshaw Mountains region. Note the 

geometries of the topographic highs in the area would have created a topographically induced 

stress field in every direction around the study area (Figure 19).  

Figure 184- Calculated crustal thicknesses during 
the Laramide orogeny by Chapman et al (2020) with 
study area circled in red. 
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Future work 

Best (1988) asserts that the orientation of paleostresses in tectonic regions is often 

hindered by uncertainties in the available data and that the conventional approaches to 

paleostress analysis, like analyzing dikes, faults, or joint orientations, can be impacted by pre-

existing anomalies and lack proper temporal constraints. Preexisting features are not an issue in 

this study of Laramide plutons since they solidified not long before formation of the fractures. 

Figure 19- Predicted landscape evolution using sediment isopachs taken from Chang and Liu 
(2020).  
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Ren et al (1989) used healed microcracks in quartz grains from dated granitic rocks as 

paleostress indicators. The microcracks, which are tensile fractures and occur as a result of 

secondary fluid inclusions or differential stresses at grain boundaries, reflect the influence of both 

thermal and regional tectonic stresses. The formation of these microcracks begins when the 

granite has cooled to around 600-700°C and has been established to provide insight into the 

regional tectonic stress field. Combining microcrack analysis with macroscopic fractures may 

further improve the accuracy and reliability of this approach. 
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ENHANCING REMOTE EDUCATION AND DIFFERENTIATED INSTRUCTION THROUGH 

HIGH-RESOLUTION MODEL CREATION WITH STRUCTURE-FROM-MOTION 

PHOTOGRAMMETRY 
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CHAPTER 7 

INTRODUCTION 

Background 

The current educational era is typified by rapid technological advancements. These 

advancements are pervasive across various educational fields, but they are evident particularly in 

the emergent use of 3D technologies in the geosciences. As geoscience educators, it is 

imperative for us to recognize the growing significance of incorporating this technology into our 

instructional design. Westoby et al. (2012) explore the various forms of 3D technologies that have 

been developed and adapted specifically for geoscience education, placing special emphasis on 

how Structure-from-Motion (SfM) is gaining utility and efficacy among educators. The rise in the 

popularity of 3D technology is likely attributable to its relative affordability, ease-of-use, and the 

many recent innovations that have led to faster processing and higher-resolution outputs. 

While this is exciting, there is a growing concern that a significant number of our 

geoscience educators, especially those at the secondary level, may not currently possess the 

requisite knowledge or skills to effectively integrate these technologies into their curriculum (e.g. 

Anderson et al., 2020; Cho and Clary, 2020). Instructors who are actively engaged in pedagogical 

improvement frequently seek out information that keeps them up-to-date on the latest 

technological advancements in their disciplines, and detailed instructional guidance on how to 

create or implement 3D models is may prove exceedingly beneficial to them. Several authors 

have provided clear and concise instructions on how to create SfM 3D models and limited advice 

on how to incorporate those models into their instruction (e.g. Arrowsmith et al., 2019; Gil-

Docampo et al., 2019; Apopei et al., 2021), which are valuable assets for any educator's 

professional development and training. While such guides are informative and comprehensive, 

they may still present a high barrier to entry for educators who are novices to these technologies. 

As a former K-12 teacher, I’ve both observed and personally experienced these barriers. 

The following study is aimed at geoscience educators who have limited knowledge and 

experience with the software, hardware, and techniques required to create high-resolution 3D 

models. The study presents a technology-focused professional development and training 
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program specifically designed for these educators who lack a background in the underlying 

technologies and techniques. The aim of this work is to provide an exhaustive guide touching on 

all the key principles, practices, and tools needed to become consistently proficient in the creation 

of 3D models. These models then can be integrated into classroom instructional design. This 

knowledge base will enable educators to further cultivate the skills and understanding needed to 

provide students with engaging and differentiated learning experiences. The outcome of this 

study will be a small contribution towards a better prepared and equipped geoscience teaching 

workforce. 

 

Motivation and Purpose 

In 2020, the COVID-19 pandemic disrupted traditional approaches to field-based 

geoscience instruction, necessitating a shift towards distance learning for most courses. Online 

learning posed challenges for delivering field-based instruction, but the utilization of Structure-

from-Motion (SfM) photogrammetry offered one solution for this problem. With a sense of 

urgency, I chose to try and enhance the educational experience of students at Arizona State 

University during this difficult time. To accomplish this, I embarked on research centered on 

establishing a method for the consistent creation of high-resolution 3D assets to be used in 

geological education at all educational levels. The methodology was refined over an extensive 

iterative process, encompassing hundreds of hours of work and thousands of iterations, all with 

the objective of enriching the geoscience student learning experience. A select few of the models 

created during this research can be accessed on SketchFab (https://sketchfab.com/ASUSESE). 

The methodology is centered on the goal of producing 3D assets to complement 

traditional field and lecture courses, offering students an interactive and unique learning 

experience. The methodology was used to create high-resolution, 3D assets of hand-samples 

that enable students to observe and interpret for extended periods of time. Specific efforts were 

made to produce textures with sub-millimeter resolution textures in hand sample models and sub-

centimeter resolution textures in outcrop models. This level of resolution is difficult to achieve for 

https://sketchfab.com/ASUSESE
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novices but critical for student understanding and analysis. With this guide, a desired level of 

resolution can be achieved every time. 

 This type of learning approach is especially useful for students who struggle with 

information processing, experience anxiety when working under time constraints, or have 

physical limitations that prevent them from participating in field studies (Andrews et al, 2020). 

Using the methods described in this thesis allows for educators to create innovative and effective 

modalities for differentiated instruction. Differentiated instruction, which for this paper will be 

simply defined as providing instructional modalities to meet individual student needs and abilities, 

is crucial to best meet the needs of a diverse group of students found in almost every classroom 

(O’Meara et al, 2010) 

 

Structure-from-Motion 

This study will provide a very brief overview, but for a more comprehensive 

understanding of SfM, including its history, please refer to the Geological Society of America 

(GSA) short course: High Resolution Topography and 3D Imaging II: Introduction to Structure 

from Motion (SfM) Photogrammetry (Arrowsmith et al., 2019).  

Structure-from-Motion (SfM) photogrammetry is a technique used to generate three-

dimensional, color-coded point clouds of an area or object of interest from a series of overlapping 

photographs. For the technique to work, the camera or the object of interest must be continuously 

moving so that no two photos are taken from the same location. Adequate photograph overlap is 

crucial because the algorithms used to create the point cloud require multiple views of the same 

feature to assign a point (Figure 20 & 21). Therefore, a higher photo density results in a more 

Figure 20- Examples of matching features (red circles) in sequential images. SIFT algorithm used 
in Metashape SfM to recognize features, align photos, and generate sparse point cloud. 

https://kb.unavco.org/article/gsa-2019-short-course-510-high-resolution-topography-and-3d-imaging-ii-introduction-to-structure-from-motion-sfm-photogrammetry-869.html
https://kb.unavco.org/article/gsa-2019-short-course-510-high-resolution-topography-and-3d-imaging-ii-introduction-to-structure-from-motion-sfm-photogrammetry-869.html
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detailed point cloud (Figure 22). The images used to illustrate these concepts were taken from 

Agisoft Metashape SfM.  

It is important to note that the scale of features, perspective of the photographs, or the 

degree of illumination may impact the capacity of the software to align the photographs. To 

minimize this issue, it is recommended to have a higher photo density and increased image 

overlap. 

Figure 21- Image overlap examples. Blue lines show Metashape's tie points (matching points) 
between two sets of photos. Good overlap (left image) with over 10,000 tie points. 

Figure 22- Example of 84 photos aligned to generate sparse point cloud. 
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Each point in the sparse cloud requires multiple cameras to have a matching pixel. The 

higher the number of photos associated with a given pixel, the stronger the alignment and quality 

of the 3D model will be (figure 23).  

 The production of a high-resolution 3D model and texture from an outcrop or hand 

sample using SfM can be broken down into the following steps: 

1. Planning for and acquiring photographs 

2. Post-processing of photographs for use in photogrammetry software 

3. Creation of a sparse cloud and determination of camera locations 

4. Production of a 3D model using depth maps and/or a dense cloud 

5. Creation and further post-processing of the model texture (a photograph draped 

over the model) 

6. Uploading and annotating on a hosting website 

This guide provides comprehensive instructions for each stage of creating 3D models for 

geoscience education. However, given that programs are constantly evolving, the methods 

outlined in this study should be used as a foundation for experimentation and exploration and not 

considered definitive. Also note that information and instructions related to a specific stage of the 

Figure 23- Finalized textured model produced through the iterative process outlined in this guide. 
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workflow may be found throughout various sections of the study or repeated. The refinement of 

this study is an ongoing process.
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CHAPTER 8 

HARDWARE 

This section is not meant to be exhaustive in its coverage of various hardware 

requirements. Rather, its purpose is to outline options that can lead to the repeatable creation of 

optimal 3D assets, without implying that all processes listed are mandatory. It is possible to 

create 3D models with an inexpensive camera, or smart phone, and a mid-range PC. Less 

expensive alternatives are always available, but the following tools were determined to lead to the 

highest quality assets. Not all models created during the tutorial utilized the full range of hardware 

recommended in this section. For comparison, all models posted on the SESE SketchFab 

account (https://sketchfab.com/ASUSESE/models) at the time of this tutorial were created using 

the following PC and camera configurations: 

 

HARDWARE MIN. 
REQUIREMENTS

* 

ADVANCED 
RECOMMENDATIONS 

** 

TESTED 
PC #1*** 

TESTED 
PC #2 

TESTED 
PC #3 

CPU 4-8 cores (2.0+ 
GHz) 

6-32 cores (4.0+ GHz) i7-2600k, 
4 cores 
(3.4 GHz) 

Xeon E5-
1650 V3, 
6 cores 
(3.5 
GHz) 

i9-9900k, 
8 cores 
(3.6 GHz)  

RAM Up to 32 GB 64-128 GB 16 GB 32 and 
64 GB 
(2400) 

64 GB 
(3200) 

STORAGE Not listed SSD (M.2) SSD (M.2) 2.5’ SSD 
(SATA 
6gb/s) 

SSD (m.2) 

GPU 700+ CUDA / 
shader cores 

Nvidia 20 super or 30 series Integrated 
graphics 

1x 1060 
6GB & 
2x 1060 
6GB 

2x 980Ti  
& 
2x 3060Ti 

Table 1- Recommended and Tested PCs 

* As indicated by the Metashape website. 

** As indicated by the Puget Systems website. 

*** lower-end laptop was utilized solely for processing at the minimum settings for identifying 

coverage gaps during field work. It is adequate for on-site checks but not for complete 

processing. 

 

 

https://sketchfab.com/ASUSESE/models
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Camera  Drone Peripherals 

DSLR or equivalent At least 20 MP Quality tripod and extension pole 

At least 20 MP Ability to shoot RAW format Light tent or box w/ Backdrop 

Native Focal Stacking Versatile lens Turntable* 

Ability to shoot RAW 
format 

UV and Circular polarizer 
filters 

Extra memory 

Versatile lens Drone license Extra batteries ** 

UV and Circular polarizer 
filters 

Capable of automated 
missions (Waypoint 2.0) *** 

Adjustable 5000k LEDs w/ light 
diffusing material 

Macro and telephoto 
attachments 

 Trigger remote 

  Scale bars 

  Specimen support stand **** 

Table 2- Recommended Cameras and Peripherals 

* A turntable can be readily replaced by manually rotating the object. 

** An inexpensive dummy battery for a DSLR camera is even better. 

*** An added advantage is if the codec is compatible with mapping software such as 

Pix4Dmapper. In this case, purchasing an older model with known compatibility is an 

advantageous option. 

**** A support stand is necessary for objects with irregular shapes (refer to "Acquiring Images"). 

 

 

 CANON 250D/SL3 DJI MAVIC AIR 2 

MEGAPIXELS 24.1 48 

PIXEL DIMENSIONS 6000 x 4000 8000 x 6000 

Table 3- Tested camera specifications. 
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CHAPTER 9 

SOFTWARE 

Just as with the hardware section, this section is not comprehensive in its coverage of 

available software options. Its aim is to highlight the options that can result in the optimal 

outcome, but not to imply that all software options are listed. Alternative software options, that are 

often low-cost or free are available but this guide will not provide guidance on them as limited 

testing was conducted, or results were not as satisfactory. Most of these software options have 

been discussed and benchmarked in great detail (e.g., Rahaman and Champion, 2019; Jones 

and Church, 2020). Although more affordable alternatives exist, the following tools have been 

found in this study to produce the highest quality assets. For comparison, all models available on 

the SESE SketchFab account (https://sketchfab.com/ASUSESE/models) at the time of this 

tutorial were generated using the following software: 

 

 

Image Capture Post-
Processing 

Rendering Hosting 

Canon EOS Utility (PC -> DSLR) * Adobe suite* Agisoft 
Metashape* 

SketchFab* 

Canon Camera Connect (Mobile -> 
DSLR) * 

Helicon Focus*   

DJI Fly (Mobile -> Drone)    

Pix4DCapture & Ctrl+DJI (Mobile -> 
Drone) 

   

 

Table 4- Tested software for each phase of 3D model construction. 

 

 

 

 

 

 

https://sketchfab.com/ASUSESE/models
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CHAPTER 10 

PLANNING AHEAD 

Camera 

Before selecting a camera for 

capturing a target area or object with the 

goal of creating a geospatial model, it is 

important to consider the following factors: 

Camera Sensor Size: The size of the 

camera sensor (figure 24) is a factor that 

affects image quality. While its direct 

importance is a topic of discussion, in 

general, a larger sensor size has the 

potential to produce higher quality images.  

Image Aspect Ratio: When multiple 

cameras are used to create a single 

model, such as with a combination of 

drone and handheld imagery, the aspect 

ratio (figure 25) of the cameras can 

become an important consideration. 

Ideally, it is best to use a single camera to 

avoid issues with aspect ratio, but if 

multiple cameras are necessary, there are 

post-processing solutions available to address this issue.  

Higher Megapixel Count: Having a higher number of megapixels (figure 26) does not guarantee a 

better picture, but it does provide Metashape with a greater number of data points to use as tie-

points in the creation of a 3D model. The additional data points can enhance the accuracy and 

detail of the final model. 

Figure 24- Sensor size: "File:Image sensor sizes in 
current digital cameras (updated as of Sep. 21st 
2011).png" by Several authors quoted on that page 
is licensed under CC BY-SA 3.0. 

Figure 25- Aspect Ratio: ""Dr. Kerns Powers, 
SMPTE derivation of 16-9 aspect ratio" by 
MarkWarren is licensed under CC BY-SA 3.0. 
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Raster Formats: The type of raster format that 

a camera can shoot is important to consider. 

JPGs are commonly used for web and print 

photos and quick previews. PNGs have 

transparency layers and can display a large 

number of colors. TIFFs are best suited for 

high-quality print graphics and scans. RAW is 

the unprocessed data from digital cameras 

and is the preferred format for creating 

geospatial models. It is important to ensure 

that the camera can shoot images in RAW 

format.  

Focal Length (f/x): Every lens has a focal 

stop that produces the sharpest images, 

known as its "sweet spot." The values for 

the sweet spot have been tested and are 

widely available online. A quick search 

using the specific lens information can 

provide these values, allowing for the 

optimization of image quality.  

Lens: To meet the needs of 

photogrammetry, it is important to 

research a versatile lens that can perform 

well in a range of shooting scenarios. It is 

highly recommended to have a main lens, 

as well as macro and telephoto 

attachments and lens filters, such as a 

circular polarizer. Cameras with ultra-wide 

Figure 26: Effective Megapixels: Dicklyon at English 
Wikipedia, Public domain, via Wikimedia Commons 

Figure 27: Raster Formats: "Image formats by 
scope" by Jon Sneyers is licensed under CC BY-SA 
4.0. 

Figure 28- Focal Length and Depth of Field: “Depth 
of field in photography explained” by Dan Zafra via 
capturetheatlas.com 
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angle, or fish-eye lenses, such as GoPros, produce 

highly distorted images and are not typically suitable 

for photogrammetry purposes.  

Focus Stacking/Bracketing Capabilities: When 

evaluating a camera for photogrammetry, it is 

important to consider its built-in focus stacking or focus 

bracketing capabilities. These features can improve 

the quality of the model and save time, compared to 

achieving these effects through post-processing. If the 

camera does not have this functionality natively, it is 

possible to check if it is supported by third-party 

software such as Magic Lantern 

(https://builds.magiclantern.fm/) or CHDK 

(https://chdk.fandom.com/wiki/CHDK) which can be 

added to the camera’s operating system. However, it 

is important to note that these software options are not 

officially endorsed by the camera manufacturer and it 

is essential to read and understand any associated 

disclaimers before installation and use. 

 

Environmental 

The ideal environmental conditions for a photoshoot involve a balance of both art and 

science. It is recommended to plan and control these variables in advance, whenever possible: 

Distance Between Camera and Area/Object: The distance from the subject has a significant 

impact on the number of images needed for adequate coverage. Taking photographs closer to 

the subject requires more images for complete coverage, but results in a higher resolution texture 

and model. On the other hand, taking photographs from a distance requires fewer images and 

results in faster rendering. The distance from the subject may also influence the type of lens 

Figure 5- Lens and peripherals: "New 

Camera Lense! / 新しいカメラレンズ" 

by Dakiny is licensed under CC BY 2.0. 

Figure 30- Focus Stacking: “What Is 
Focus Stacking?” by Spencer Cox via 
www.photographylife.com 

https://builds.magiclantern.fm/
https://chdk.fandom.com/wiki/CHDK
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required, such as a macro or telephoto lens. For submillimeter resolution on hand samples, it is 

highly recommended to use a macro lens. 

Scale of the Area or Object Being Photographed: When creating a 3D model, it is important to 

keep in mind the file-size limitations of most hosting websites. If the goal is to model a specific, 

small area, such as a 3 x 3 ft section of an outcrop with features of interest, capturing and 

rendering a larger 30 x 10 ft section may result in the downscaling of the texture to fit within the 

hosting site's file size constraints. This could lead to a loss of resolution and detail in the final 

model. To avoid this, it is important to carefully consider the size of the target area when planning 

the model process and ensure that the shots match the desired scale of the final model to be 

displayed. 

Photoset Geometries: It is widely agreed that photosets with a sub-parallel orientation and a 

minor convergent component (figure 31, 

bottom) are the optimal way to capture 

static surfaces for photogrammetry (e.g. 

Arrowsmith et al, 2019; Apopei et al, 

2021). Each photograph should have an 

Coverlap of between 60-80% for improved 

alignment and coverage. To enhance 

overlap and improve alignment, it is 

recommended to create photosets at varying distances. While overly oblique camera angles may 

increase overlap, they do not result in a high-quality texture. The resolution and quality of the 

texture are determined by the closest set of photographs, so it is important to ensure adequate 

coverage in this set. Using multi-level photosets can improve the alignment and quality of the 

mesh model, but it will not directly enhance the texture quality. If there are gaps in coverage in 

the nearest photoset, they will be filled with photographs from a more distant set, which can result 

in noticeable disparities in texture resolution.  

Lighting Considerations: When conducting a photoshoot, it is important to try to find or create 

conditions with diffuse lighting. Diffuse lighting helps to reduce shadows and enhances the 

Figure 31- Example photoset geometries. From 
Arrowsmith et al (2019) 
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texture quality of the final model. Additionally, using a white balance card between photosets can 

help to generate accurate color textures during post-processing. For more information on lighting 

conditions for photogrammetry, you can refer to the YouTube tutorial by ClassyDogFilms, which 

provides a brief but informative guide for both outdoor and indoor lighting conditions 

(https://www.youtube.com/watch?v=9_F-b2hxP_o). 

Ground Control Points (GCPs) or GPS: Markers, also known as ground control points (GCPs), 

can be used to improve the accuracy of camera alignment in photogrammetry (figure 32). To use 

GCPs, simply print out the targets provided by your photogrammetry software (such as 

Metashape), place them strategically around the object or area of interest, and then instruct the 

software to automatically detect them in the photoset. The use of GCPs can help to increase the 

accuracy and precision of the final 3D model. However, when photographing outcrops with a 

drone or GPS-tethered camera, the use of GCPs may not be necessary. This is because most 

photogrammetry software can use the precise GPS coordinates in the photograph's metadata to 

aid in the alignment process.  

 

 

File Hierarchy 

With the diversity and complexity of the branching workflows presented in this guide, it is 

easy to misplace or use files incorrectly. To avoid this, establish a predetermined and consistent 

system for organizing your files. Each photograph you take will likely undergo up to four different 

transformation stages, so it is important to keep each iteration of the photograph intact until you 

Figure 32- Metashape generated Ground Control Points (GCPs) and their application.  
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have uploaded a satisfactory completed 3D model to a hosting location. Even after the model is 

complete, you may want to make changes. Having a large cloud storage or an inexpensive large-

capacity hard drive (commonly referred to as a ‘Cold Storage’) will make these files available for 

future use. An excellent, but more expensive, option is a Network-Attached Storage (NAS) drive 

with multiple hard-disk drives. These feature large capacities and drive/data redundancy that 

prevent any loss of data due to failure of a single drive. Synology is a top-performing brand. The 

file hierarchy for your project is your choice and customizable to your needs, but below is a brief 

outline of what was used when creating models for this guide. 

 

Required for Photoshop Scripted Focus Stacking 

It is important to note that if you choose to use the Photoshop focus stacking script 

provided (https://github.com/AdemaRuh/Focus-Stacking-via-Photoshop), it is necessary to follow 

the specified file hierarchy exactly as outlined. If you do not follow this hierarchy, the script will not 

function correctly unless you have the technical ability to manually edit it to suit your needs. The 

principles outlined can be applied to all workflows, not just the Photoshop script workflow, for 

ease of organization. 

Folder Level Folder Explanation Example titles 

Project Highest level folder for a given project sed_labs 

Main Category which the model falls into ‘handsample’ or ‘outcrop’ 

Master Sample or scene ID sed_7_pc1 

Image Four fixed folders always have the same format: 
0-Raw 
1-Processed 
2-Stacked 
3-Focused 
 

Stack Sets Format is fixed and found in 1-Processed folder  Set 001, Set 002, Set 003… 

Table 5- Explanation of the hierarchical terms used in the outlined file organization system. 

The names of the ‘Project,’ ‘Main,’ and ‘Master’ folders can be chosen according to your 

preference or naming scheme. However, the ‘Master’ folder must contain the four folders named 

exactly as shown. The ‘1-Processed’ folder must contain ‘Stack Set’ folders in the format: 

‘Text{'Set'}{' '}’Series{000}’ as seen in the example in Table 5 and Figure 34. Also, please note 

that for outcrops, the folders '1-Processed' and '2-Stacked' may be skipped as these types of 

https://github.com/AdemaRuh/Focus-Stacking-via-Photoshop
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photosets typically don't have depth of field issues that require focus stacking. These can also be 

skipped for hand samples if your camera has native focus stacking capabilities. 

Folder Creation Workflow: 

• Choose the hard drive where the project will be stored. (Slow HHD (E:) in figure 34) 

• Create a ‘Project’ folder. 

Figure 33- Example File Hierarchy graphic. Use throughout workflow for reference.  
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• Add the necessary ‘Main’ (Handsamples in example) and ‘Master’ (sed_7_pc1) in 

example folders.  

• Create the required Image folders (Table 5). 

• Sort the photographs exported from Lightroom (discussed in ‘Lightroom’ section) into the 

‘Stack Set’ folders: 

o Sets, or ‘Stack Sets,’ are 

defined in the ‘Acquiring 

Photos for Hand Sample 

Models’ section. 

o To avoid creating potentially 

hundreds of ‘Stack Set’ 

folders manually, you can 

create them in advance using 

a .bat file.  

Figure 34- Example of Set Stack folders. 

Figure 35- Creation of a .bat file 
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▪ A .bat file can quickly generate a set of folders with a predefined and 

systematic naming scheme. 

o Right-click in the ‘1-Processed’ folder where you want to save the stack sets. 

o Choose ‘New’ then ‘Text document’ (Figure 35). 

o Paste the following text 

as written to the right:  

o If you want to create a 

specific number of ‘Set 

Stack’ folders (e.g., 

number 300 to 350), 

change the FOR line to: 

FOR /l %%N in   

(300,1,350) do ( 

o Save the file as 

‘numberedfolders.bat’ 

with the ".bat" extension (figure 36).  

o Click on the .bat file to automatically create all ‘Stack 

Set’ folders. 

o Copy this .bat file and place it in the ‘Main’ level folder 

and future ‘1-Processed’ folders for future ‘Stack 

Sets’. 

• Fill the ‘0-Raw’ folder with the raw images you acquired 

from the photoshoot.  

• Skip to ‘Acquiring Photos for Hand Sample Models’ section if these have not yet been 

acquired.  

• Fill ‘1-Processed’ with exports from post-processing software of choice (See ‘Lightroom’ 

section). 

Figure 36- Example .bat 
file for creating 300 ‘Set 
Stack’ folders. 
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o Create additional ‘Set Stack’ folders in ‘1-Processed’ and sort photographs into 

appropriate folders. 

• Fill '2-Stacked' folder with the focus stacked products obtained from your focus stacking 

process of choice. 

• Fill the "3-Focused" folder with dual-masked TIFF files (see ‘Dual-Masking’ section), 

which will be used in Metashape to generate the model. 
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CHAPTER 11 

ACQUIRING IMAGES 

 

Hand Sample Model Workflow 

 

• Set up your light box or photo tent 

with a turntable.  

o A black backdrop and 

turntable are preferred, 

but a white option is also 

acceptable.  

o The setup can range from 

simple to elaborate, as 

desired. (Refer to the video by ClassyDogFilms in the ‘Pre-shoot Considerations’ 

section for more information). 

o This study utilized a modified Foldio360 lightbox/turntable setup, with a black 

background (as shown in Figure 37). However, it was found that using a 

cardboard box lined with black construction paper and manually rotating the 

subject also produced comparable results, although it took more time to complete 

the model and resulted in less consistency. 

Figure 37- Example of a Light Box. 
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• Light the Model 

o Place large, powerful LED 

lights about 1-2 meters away 

from the subject and use a 

diffusion material to distribute 

the light evenly and reduce 

shadows (Figure 38).  

o Place smaller lights in the 

foreground with remote-

controlled variable brightness. These smaller lights are much closer to the object 

and can be manipulated to eliminate any remaining shadows. 

• Place the camera on a tripod and the sample on a support structure.  

o A support structure is crucial 

in capturing objects with 

complex shapes and for 

holding objects at angles that 

would otherwise be difficult to 

achieve. 

o Match the color of the 

backdrop, turntable, and support structure to simplify the ‘dual-mask’ creation 

stage.  

▪ For the support structure, I used a ring made of black spandex filled with 

Kinetic Sand (as seen in figure 39). The color and texture of the ring 

matched the backdrop and turntable, making it an effective and visually 

appealing solution that I highly recommend. 

o Minimize vibrations to the camera and the model by setting them up on sturdy 

and stable surfaces.  

Figure 38- Powerful lights with diffusion material. 

Figure 39- Support structure. 
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▪ This also has the added benefit of achieving consistent angles between 

each photo in each set. 

• Place the object on the turntable and turn on the camera. 

o Adjust variables such as lighting, focal distance, and orientation. 

 

Camera Settings 

The following settings are typically recommended, but they can be adjusted based on your 

specific needs: 

• Use a remote trigger setup, such as done with a phone, computer, or camera-specific 

remote to take photographs. (Refer to the section on 'Focus Stacking' for more 

information.) 

• Use manual mode (M) on the camera instead of automatic to ensure consistent 

exposures. 

• Capture images in RAW (or RAW and JPEG) format. 

o RAW files will be converted to JPEG later, so if you are concerned about space 

or time, do not produce JPEGs at this stage. 

o Processing RAW photos in batch is much more efficient and faster than 

processing JPEGs. 

o If you do not have access to Adobe Suite, consider using free software like 

Canon's Digital Photo Professional (CDPP) to achieve the same results as 

outlined in Adobe Lightroom later. 

• Low ISO is preferred for high-quality images. 

o Lower ISO results in less graininess in the image. 

o It enables closer zooming without causing blurriness, improving pixel matching in 

Metashape. 

o However, lower ISO requires more lighting on the hand sample. 

o For optimal results, use an ISO of 200 or lower. 

• Aperture, or f-stop, ‘sweet spot’  
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o Lower apertures produce sharper images but lower the camera’s depth of field. 

o Correcting for sharpness in post-processing is much easier than for depth of field 

issues so a sweet spot between the two is needed. 

o A standard recommendation of f/8 to f/13 is given for macro-scale hand sample 

photogrammetric projects but these values are highly dependent on your lens 

and set-up. 

▪ Unless using a native focal stack or Helicon Remote, it is not 

recommended to go below f/11-13. 

• Shutter speed should be adjusted based on the lighting conditions. A typical shutter 

speed range is 1/8th to 1/15th of a second. 

o Brighter light allows for faster shutter speeds, which reduces the number of 

aberrations and noise in the image. 

o Many modern cameras have built-in exposure meters that can be used to 

determine the ideal shutter speed for proper exposure. 

• It is recommended to turn off image stabilization while capturing images. 
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Starting the Shoot 

• Ensure that the entire hand sample or scene is captured in the camera frame. 

o The closer the camera is positioned to the hand sample or scene, the higher the 

resolution of the final model will be. However, if you choose to get too close so 

that each photograph only shows a portion of the specimen, it can lead to several 

complications.   

o These complications may include, but are not limited to: 

▪ The need for more photographs, 

▪ Increased calculation time, 

▪ Larger file size, 

▪ Complicated masking process, 

▪ Higher chances of alignment errors between photographs.  
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• To ensure all surfaces of the object are captured from multiple angles, create a sphere of 

photograph orientations, referred to as "cameras," that provide enough overlap. This is 

illustrated in Figure 40.  

o This can be accomplished by designing a well-planned shoot. First assigning 

axes to the subject or object and note them on paper. 

▪ This will trick Metashape 

into recognizing the 

photosets as 

omnidirectional.  

▪ The x, y, and z axes can 

be arbitrary.  

• For each x, y, and z orientation, follow these 

steps (referred to in Figure 41): 

o Place the object on its x-axis 

o Position the camera in one of three static positions relative to the turntable 

surface: 

▪ Approximately 0° horizontal (facing the horizon of the turntable surface), 

▪ Approximately 30° above the horizon, 

▪ Approximately 50° above the horizon. 

Figure 6- On the left is a common representation of the ‘ideal’ camera locations (blue boxes) 
required for a good model. The center and right images are representative of the camera 
locations and photo density from this workflow, which ensures complete coverage of all faces 
regardless of their complexity. 

Figure 41- Object with assigned x, y, and 
z axes. 
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• When taking a photograph or a series 

of photographs for focus stacking 

(refer to the focus stacking section), 

make sure to take one shot every 10 

to 20 degrees of rotation. On average, 

you should expect to take between 18 

shots (for 20° rotation) to 36 shots for 

(10° rotation) photographs or ‘Stack 

Sets’ for each camera angle. 

o The focus should be on 

capturing high-quality 

textures.  

o The accuracy of the 3D model 

(mesh) should be a 

secondary concern. It is 

straightforward to create a 

mesh with sufficient precision, 

but creating high-definition 

textures is more complex.  

o To create a good mesh, only 

a few instructions are needed. 

o Creating high-definition 

textures is a much more 

complex process than 

creating a mesh.  

• Repeat this process for each camera position (0° / 30° / 50°) as seen in Figure 42. 

o To make sorting the thousands of photos from a shoot easier, you can 

photograph an indicator (such as a labeled paper) in front of the camera between 

0 

30 

50 

50 

0 

30 

50 

30 

0 

Figure 42- Take photographs at approximately 
10° intervals for each camera position and then 
repeat the process for each axis. 
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each series. This will allow you to identify each series quickly and easily in large 

thumbnail view. 

o Taking such a large number of photographs may seem excessive, but it will save 

you time in the long run. Without sufficient coverage, you may end up having to 

retake photographs, process, and render them again. This is a common scenario 

when striving for a high-quality model. To avoid this issue, it is recommended to 

take many photographs. 

 

Outcrop Model Workflow 

In general, it is best to use high-resolution cameras (greater than 8 MP), collect images in 

RAW format. 

• Determine the Survey Area: 

o Clearly define the boundaries of the survey area based on the objective of the 

model to be created. 

o Make sure the survey area is easily accessible and safe to enter. 

o Check for any flight restrictions in the area if using a drone. The DJI Fly app will 

alert you if you are in a restricted zone.  

• Plan the Survey: 

o Determine the optimal time of day to take photos based on lighting conditions (11 

am to 4 pm with soft diffuse lighting, such as a light overcast, is preferred). 

o Plan the survey route to ensure optimal coverage of the outcrop. 

o Determine the number of photos needed to achieve the desired 80% overlap and 

60% sidelap. 

• Set up Ground Control Points (if applicable): 

o Place ground control points in the survey area if necessary for accurate 

georeferencing.  

o Record the GPS coordinates of each ground control point. If using a drone with 

integrated GPS, this is not necessary.  
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• Place Scale Bars and References on the Outcrop: 

o Place scale bars and references on the outcrop to provide a reference for the 

size and orientation of the outcrop in the photos. 

• Adjust the Camera Settings: 

o Set the camera to manual mode.  

o Choose the aperture (f/8 to f/16 is best) based on the lighting conditions.  

o Select the ISO and shutter speed based on the lighting conditions.  

• Acquiring Photos: 

o DSLR by Hand: 

▪ Handhold the camera and take photos while walking around the outcrop. 

▪ Ensure 80% overlap and 60% sidelap between photos. 

o On a Tripod or Extension Pole: 

▪ Mount the camera on a tripod or extension pole. 

▪ Take photos while rotating the tripod or adjusting the height of the 

extension pole. Use the principles outlined in ‘Environmental section.’ 

▪ Ensure 80% overlap and 60% sidelap between photos. 

o With a Drone: 

▪ Check to see if you are restricted airspace.  

▪ Make sure you are legally allowed to fly in your area.  

▪ Launch the drone and fly it over the outcrop using waypoint flight path 

plans from apps like DJI Fly, Pix4DCapture, or Ctrl+DJI.  

• Design a flight path that has multiple levels (see figure 12).  

▪ Use the drone's camera to take photos while following the planned 

survey route.  

▪ Ensure 80% overlap and 60% sidelap between photos. 

▪ Avoid High Wind Conditions: 

• Do not take photos during high wind conditions as it can cause 

movement in the photos. 
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CHAPTER 12 

FOCUS BRACKETING 

Focus bracketing is a common technique used for macro photography that allows the 

user to capture multiple images of the same subject at different delimited focal distances. This 

allows that all parts of the subject are in focus in at least one of the collected images. While focus 

bracketing is part of the 'Image Acquisition' process, it deserves its own category. If you do not 

plan to use focus stacking, you can skip this section. Focus bracketing is the step responsible for 

creating the ‘Stack Set’ images that will ultimately be stacked together into one image. Focus 

Stacking is a relatively new addition to our workflow, but it has produced significant 

improvements. 

•  The main challenge in creating believable 3D models is to create the illusion of reality. 

• Achieving submillimeter resolution and avoiding textural smearing helps to create a more 

lifelike texture, enabling both qualitative and quantitative analysis. 

• To avoid ruining the illusion of reality, it is important to capture every surface of the object 

in focus and from multiple perspectives. 

• Capturing large or irregularly shaped objects with a large depth of field range in focus 

from multiple perspectives can be challenging. 

• Many high-end cameras have built-in focus stacking software that performs the stacking 

operation automatically. Some older Canon cameras also have the option to install third-

party software with focus bracketing/stacking capabilities. 
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• Focus stacking or focus bracketing helps resolve the limitations of macro photography's 

depth of field by combining the sharpest sections of a series of photos (Figure 43).  

• If your camera does not have built-in focus stacking software or you prefer not to use 

third-party software, alternative options are available. 

• There are many focus stacking options, but only three main workflows will be covered in 

this guide, listed in order of least preferred to most preferred. 

o Selective or manual focus with remote connection, then stacked in Photoshop. 

o Shift focus with remote connection, then stacked in Photoshop. 

o Use Helicon Remote and stack in Helicon Focus (strongly recommended). 

▪ Built-in focus stacking is still the gold standard the most highly 

recommended.  

 

Selective or Manual Focus Method 

The following process may take some time, but it is easy to start with: 

• Position the camera or object so that the desired object is in the frame.  

• Manually select a near-field focus area on the object by using the camera's on-screen 

display or by rotating the manual focus ring until the selected point is in focus. 

Figure 43- Depth of Field and the use of 'Stack Sets' 
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o Many camera models come with 

accompanying cell phone applications 

that allow for remote shooting and 

selective focus stacking. These apps 

enable manual selection of focal points 

without touching the camera, reducing the 

risk of camera shake or changes in 

orientation (Figure 44). 

• Focus on any planes in the frame that are 

perpendicular to the camera lens and, if possible, 

on any corners or edges close to the lens. 

• Create ‘Stack sets’ by taking multiple images 

without moving either the camera or the object. 

Alternate between near and far-field points of interest on the object for each stack set. 

o This can be done with as few as two photos, but generally, more images result in 

more surface being in-focus. 

o Beginners should take more photos per stack set than they think they need. 

Experience leads to increased familiarity with the proper number of images 

needed for a given setup. 

o Use a signifier between ‘Stack Sets’ to indicate that one set of photos is complete 

and the next has begun. 

▪ Hold a colored paper or white balance card between the camera and the 

object and snap a picture before rotating the turntable or moving the 

camera. 

▪ This step will save time and frustration in post-processing. 

• Repeat the process for each stack set until you have the desired coverage, as outlined in 

the "Acquiring Images" section. 

o Sets will be post-processed and stacked by chosen software when completed.  

Figure 44- Selective or manual 
focus. 
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Shift Focus Method 

Shift focusing mimics the focus bracketing abilities of high-end cameras and paid 

software applications by allowing the user to control the focal steps at which the camera captures 

images using computer software and a hard-wired connection to the camera. This process is 

time-intensive and only possible for cameras with a desktop utility software. The steps outlined 

below are specifically for Canon EOS cameras, which 

do not have built-in focus stacking and are not yet 

supported by Magic Lantern (such as the EOS 250D). 

However, analogous applications exist for nearly all 

major camera brands. 

• Download the EOS Utility app to a PC, Mac, 

or Linux and place the computer within a few 

feet of the tent box. 

Figure 7- The Canon EOS Utility application allows for remote control of camera settings with a 
quick view feature. 
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• Connect the camera to the PC, Mac, or Linux using a long Hi-Speed USB 2.0 cable and 

follow the on-screen instructions to sync your camera with the app.  

• Set the camera settings, choose a location to save the photos, and open the Live View 

mode using the EOS Utility app.  

• In Live View, ensure that ‘Continuous AF’ is turned OFF and ‘depth-of-field preview’ is 

turned ON.  

• Double click on the part of the object that is closest to the camera lens to focus on it. 

• Use the arrows to shift the focal ring from near-field to far-field: 

o <<< Focal shift to farthest near-field lens will allow, 

o << medium focal shift near-field, 

o  < smallest focal shift near-field, 

o  >smallest focal shift far-field, 

o  >>medium focal shift far-field, 

o  >>>Focal shift to farthest far-field lens will allow.  

Figure 46- Live View provides users with enhanced remote-control features. 
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• Determine the appropriate amount of focal shift between photographs needed to ensure 

the entire surface is in focus when all the photographs in the stack set are aggregated. 

o The amount of focal shift needed between each photograph will vary depending 

on the camera's set focal length and aperture. 

o Decide on the interval between each photograph, such as ‘taking a photograph 

every medium focal shift’ or ‘taking an image every two small focal shifts.’ 

• Begin taking photographs, starting from either the nearest-field or farthest-field part of the 

object, at your determined interval until the last photograph has the opposite side of the 

object in focus. 

• Take a photograph of your chosen indicator to signal the completion of this stack set, 

then rotate the object by approximately 10 degrees on the turntable and repeat the 

process. 

o The completed sets will be post-processed and stacked using the chosen 

software.  

 

Helicon Remote Method  

Helicon Remote is a supplementary image capture application that is used in conjunction 

with Helicon Focus, which is Helicon's primary image stacking program. Helicon Remote can be 

purchased separately, but it comes free with Helicon Focus. This section assumes that you have 

both applications. However, it is possible to use Helicon Remote or another focus bracketing 

software of your choice and then stack the images in Photoshop, which is the currently 

recommended method. If you had tried this when you first learned about it, it would have saved 

you much time. Helicon has excellent tutorials and explanations of settings on their website, and 

this video serves as a good introduction to the Remote application. 

• Check that your camera is supported by the application. This information is on Helicon’s 

website. Download and install the free 30-day evaluation period of Helicon Focus, which 

includes Remote. You can decide if you want to pay for the application after 30 days. 

• Set up your camera, lightbox, and object. 
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• Connect your camera to your PC or phone and turn it on. 

o This can be done using USB 2.0 (recommended), Wi-Fi, or Bluetooth. 

• Open Helicon Remote and turn on the camera. 

o You should see a screen like the one shown in Figure 47. From here, you can 

control many of your camera's settings and more. If the camera is supported, 

nearly all settings can be set remotely. It has expanded functionality compared to 

the EOS Utility application seen in the previous ‘Shift Focus Method.’  

• Before taking any shots, it's important to set up your own file storage system and 

experiment with the settings in Helicon Remote. Here are a few recommended changes: 

o File -> Preferences -> Interface: Increase the Live View Brightness. This will help 

you see the image better if your lighting is not bright enough. You will be able to 

adjust exposure levels later in post-processing. 

o File -> Preferences -> Shooting -> Canon: 

o Adjust the Size of focusing steps to be smaller and adjust the pause time if taking 

more than 15 shots per stack set. 

Figure 47- Primary Helicon Remote screen. 
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o File -> Preferences -> 

Shooting -> Image 

Saving: 

o Set up your file saving 

system, updating 

preferences for each 

new model shot. 

Store each stack in a 

unique folder to 

clearly distinguish 

between sets. 

o Take the time to go through and adjust Preferences to determine what works 

best for your shoot 

• Set Your Focus Points: 

o Use the Auto Focus Function: 

▪ ‘Highlight focused areas’ is a useful box to check which can help you 

determine when a desired focal point has been reached by showing 

focused regions in blue (Figure 49).  

Figure 48- Helicon Remote preferences screen. 

Figure 49- Highlight Focused Areas. 
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o Click on the auto-focus function and select the nearest part of the object you 

want to shoot. This sets your nearest focus point.  

o Verify Your Focus: 

o Zoom in to make sure that the auto-focus was accurate. If necessary, adjust the 

focus using the small step keys under Focus Bracketing. To move towards the 

camera, use ‘shift + left’ and to move towards infinity, use ‘shift + right.’ 

▪ Take a few steps closer to the camera than you think you will need, for 

good measure. 

▪ When satisfied, click the ‘A’ button to lock this position in place. 

▪ Use large steps towards infinity (>>>) until the farthest field portion of the 

object is in focus, then lock the ‘B’ button into place. 

• Helicon Remote will automatically recommend 

stack parameters based on your settings and 

camera hardware (Figure 50).  

• If the stack parameters are acceptable, click the 

‘Start Shooting’ button at the top of the page. 

o The RAW files will be automatically 

placed in your desired ‘Stack Set’ folder. 

o You will have the option to go directly to 

Helicon Focus to stack the RAW images, 

but it is not recommended at this point. It is preferable to post-process the photos 

in Lightroom first. 

• Rotate the hand sample by approximately 10 degrees and repeat the previously outlined 

steps until you have captured approximately 300 stack sets. 

• Once completed, the sets will be post-processed and stacked by your chosen software. 

 

Figure 50- The number of shots and 
number of focus steps between shots 
(Interval) can be adjusted as desired 
after deselecting Auto. 
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CHAPTER 13 

POST PROCESSING 

Post-processing is the process of editing and enhancing digital images via dedicated 

software. This process involves a broad spectrum of variables that can be adjusted, and the level 

of complexity of the tasks can be tailored according to user preferences.  

 This guide only covers Adobe Lightroom Classic, but the concepts discussed can be 

applied to any post-processing software 

you choose. Note: Adobe has rebranded 

its original 'Lightroom' program as a 

minimalist application for casual users and 

renamed the program for power users as 

'Lightroom Classic.' You will want to use 

‘Lightroom Classic’ (Figure 51). 

 

Lightroom Classic Workflow 

• Open Adobe Lightroom Classic. 

• Either click the ‘Import’ button, navigate to the RAW files in the correct ‘1-Raw’ folder, and 

import all stack sets into the catalog, or drag files from the file explorer into the 

application. 

• Select any one image from the recently imported images. 

• Navigate to the ‘Develop’ tab and edit as desired. 

o If possible, try to do this step while the sample is still in hand as a reference. If 

not, activate a reference view (Y|Y or R|Y). 

• Adjust the color, vibrance, saturation, exposure, shadows, highlights, clarity, and other 

settings as needed.  

o Do not rely on the ‘Auto Tone’ or ‘Auto WB’ features.  

Figure 51- Adobe Creative Cloud. Lightroom Classic 
displayed in the far right. 
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o If a white balance target was used, use the White Balance selector (Figure 52), 

and click on a pixel that should be neutral grey (not white or black). 

• This is especially important when 

photographing mineral samples with 

reflective surfaces, such as pyrite. 

• Always reduce highlights and shadows. 

• Removing chromatic aberrations can also 

be beneficial. 

• Synchronize these new settings across all images. 

o Ensure that the image you just edited is highlighted, then select all images 

(Ctrl/Cmd + A). 

o Click the ‘Sync Settings’ button on the bottom right and accept the changes. 

▪ This will sync any edits you made from ‘as shot’ across all selected 

images, making it much more efficient than having to edit each image 

individually.  

• Fine-tune a few different images, sync the edits, and when satisfied, export the images. 

Figure 52- White Balance Selector. 

Figure 53- Library tab in(G) Grid View. 
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o If you used Helicon products, you can download the Lightroom plugin and export 

stacks directly. However, this is not currently the recommended workflow 

because it only processes one stack set at a time. 

o Helicon Focus has a batch processing function that can be set and forgotten. 

Export to Hard Drive Choose the desired hard drive. 

Export 

Location 
Specific folder Select the '1-Processed' folder for this project's Master folder. 

File naming 

 

Custom 

Settings 

 

0000 + _sampleID 

File settings 

 

Image format 
TIFF with ZIP compression (if hard drive space is not a 

concern) or JPEG (if hard drive space is a concern). 

Metadata 
Remove 

Location Info 

Check the option for hand samples and uncheck the option 

for outcrops. 

Table 6- Suggested Export Settings. 
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CHAPTER 14 

FOCUS STACKING 

Focus stacking is a technique in photography where images taken of the same scene at 

different focus distances are combined to produce a final image that is in focus throughout the 

frame. This method combines only the sharpest parts of each image. 

Skip this section if you do not plan on using focus stacking. There are several focus 

stacking software programs available, but only three have been thoroughly tested and evaluated 

for this guide:  

(1) Photoshop << (2) Zerene Stacker < (3) Helicon Focus 

This guide will only cover the workflows for Photoshop and Helicon Focus, as Photoshop 

is widely considered a must-have tool, and Helicon Focus is favored for its remote function and 

ease of use, which is comparable to Zerene Stacker.  

 

 

Figure 54- Load Stack Layers. 
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Focus Stacking via Photoshop without Custon Script 

• Open Photoshop 

• Select File -> Scripts -> Load Files into Stack (Figure 54). 

• In the Load Layers section, click Browse. 

o Locate the desired ‘Stack Set’ folder.  

• Check the option ‘Attempt to Automatically Align Source Images.’ 

• Click ‘Okay’ 

o Photoshop will automatically align the ‘Stack Set’ images (Figure 55) 

o This function may change the resolution of the image by a relatively small 

number of pixels due to what is known as focal breathing.  

• The first time creating a focus stack image you will need to create a new action that will 

speed up future ‘stack set’ processing. 

o Creating new actions is a useful habit to develop whenever a series of tasks 

needs to be repeated more than three or four times. 

• To create a new action, select Windows -> Action. 

• Click on "Create New Action," name the action ‘Focus Stack,’ and then click on Record.  

Figure 55- Automatically Aligning Source Images. 
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o Every repeatable function you perform while recording is saved and will be 

repeated for every set of files you perform the action on. 

• Perform the following functions while the action is recording: 

o Select -> All Layers (ctrl/cmd + A) 

o Edit -> Auto Blend Layers -> Stack Images  

▪ Seamless Tone and Color-> OK 

o Image -> Canvas Size 

▪ Set to original camera resolution (in this case 6000x4000)-> OK-> 

Proceed 

o Layer -> Flatten Image 

o Return to the Action Tab and Stop Recording 

• File -> click Save as 

• Navigate to Image folder ‘2-Stacked’ -> Name the file 

o If saving files as TIFF, select Zip Compression -> OK 

o Load Files into Stack for the next ‘Stack Set’ folder.  

o After photos finish aligning, click play selection while the newly created ‘Focus 

Stack’ action is highlighted on the action tab  

o Save As with desired name  

o Repeat until all ‘Stack Sets’ have been processed.  

 

Focus Stacking via Photoshop with Custom Script  

The previous workflow can be effective but can become tedious when handling large data 

sets required for these projects. To streamline this process, a script was created to automate it. 

Although the script may not be elegantly written and took a significant amount of time to develop, 

it is now available for download (https://github.com/AdemaRuh/Focus-Stacking-via-

Photoshop.git). It is open for improvement as your skill level allows. Alternatively, you may want 

to consider using Helicon Focus, as it has proven to be a valuable solution. 

https://github.com/AdemaRuh/Focus-Stacking-via-Photoshop.git
https://github.com/AdemaRuh/Focus-Stacking-via-Photoshop.git
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• Download script file and open Photoshop (Figure 56).  

• Double click on the ATN file to load script support actions into photoshop.  

o You will only need to do this the first time you use the script and not again after. 

• Navigate to File -> Scripts -> Browse 

• Locate the 'file to stack Batch Scripting.jsx' and open it. 

• A new File Explorer window will open. Navigate to the location of the ‘Master folder’ you 

want to process.  

o The script will automatically batch process all ‘Stack Sets’ in the ‘1-Processed’ 

folder for that ‘Master folder.’ 

o It will also automatically produce a single stacked .tiff image, with ZIP 

compression, from each ‘Stack Set.’  

o The output images will also automatically be saved in the Image folder ‘2-

Stacked.’ 

• Relax and watch a movie while the script processes the images. 

 

Helicon Focus Stacking 

It is highly recommended to use Helicon Focus and is the opinion of this author that it is worth 

the cost. The application can be set up to automatically stack image sets in the background using 

the Folder Monitor Function while shooting photos in Helicon Remote. However, waiting until after 

post-processing the photographs in Adobe Lightroom Classic to stack them may yield better 

Figure 56- The contents of the linked GitHub file include a sample file hierarchy, the batch focus 
stacking script, pre-written support actions, and a brief set of instructions. 
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results. This guide primarily focuses on batch processing all stack sets at once after they have 

been modified in Adobe Lightroom Classic. 

 

Stacking Simultaneously with Shoot 

If you wish to have your subject focus stacked in real time while you are capturing images for 

each set, follow this procedure: 

• Start Helicon Focus before taking photos with Helicon Remote. 

• Go to Edit -> Preferences and adjust the following settings as desired: 

o Default output set to DPI. 

o File Save Name Template (e.g. [SOURCE_DIR]_stacked). 

o Increase the default JPEG quality to 100 or set TIFF to LZW compression (no 

ZIP option available). 

o Choose a GPU for OpenCL 

hardware acceleration. 

o Integration: Install the Lightroom 

plug-in (optional). 

• Navigate to File -> Folder Monitor 

o Select the folder where you will be 

uploading photos from your shoot. 

This should be the object's ‘1-

Raw’ folder. 

o This method automatically detects 

stack sets and produces an output 

stacked file based on the time 

between photographs taken. In 

the example shown (Figure 38), 

groups are created when any set 
Figure 57- Automatically detecting 'Stack 
Sets.' 
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of photos are separated by 10 or more seconds.  

o Choose the RAW file type if you are shooting in RAW format. 

o Choose focus parameters. 

o Choose the file save type (DNG is strongly recommended) and set the "Output 

folder" as the object's "2-Stacked" folder.  

• Click "Start" and then navigate back to Helicon Remote to begin photographing stack 

sets. 

• When finished, the designated folder will be filled with already processed stacks in RAW 

format, ready for import into Lightroom for post-processing. 

o See previous ‘Post Processing’ section.  

 

Stacking Photos Post Shoot  

If you wish to have your subject focus stacked only after you have captured the entire 

‘Stack Set’ of images, which allows you to ensure the quality and image density of the set, follow 

this procedure: 

• Navigate to Edit -> Preferences in Helicon Focus and adjust settings as desired: 

o Set the default output DPI. 

o Configure the File Save Name Template, for example [SOURCE_DIR]_stacked. 

o Scale the default JPEG quality up to 100 or set TIFF to LZW compression (no 

ZIP). 

o Select a GPU for OpenCL hardware acceleration. 

o Install the Lightroom plugin (optional). 

• Navigate to File -> Batch (F7) in Helicon Focus. 

o Batch processing values will vary depending on the specific dataset, but 

generally, for batch processing Method B, a radius of 8-12 and smoothing 

between 1-5 are recommended (Figure 58). 

o Ensure that all your Lightroom processed files are already separated into Stack 

Sets folders. 
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• Select ‘Add multiple folders’ and navigate to the object’s ‘1-Processed’ folder. Select all 

folders. 

o Keep in mind that the number of folders you can add at one time will be limited 

by your PC and main GPU's memory. 

• Adjust the Method (blending algorithm used), Radius (size of region around each pixel 

used to determine the sharpest points of the image), and Smoothing (higher value is 

softer and more blended where a lower value is more detailed but less “smooth”) 

parameters as desired.  

o Play around with these parameters on a single stack to determine values that 

work for this data set before rendering all stack sets. 

Figure 58- Batch Processing. 
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o Review the output products and perform any necessary retouching (figure 59). If 

retouching is required, save the file again and overwrite the previous version. 

• Select the down drop arrow 

and ‘apply parameters to 

other stacks.’ 

• Set autosave results. 

o If the images have 

already been post-

processed in 

Lightroom, TIFF with LZW compression or JPEG is fine. 

▪ JPEG is currently recommended because it has a smaller file size and 

the loss in image quality is minimal. 

o The lossless TIFF format has not been shown to have any significant advantages 

in Metashape's ability to render a model. 

o In the "Specified folder" section, select the "2-Stacked" folder for your object. 

• Render the images when you are satisfied with the parameters. 

Regardless of the stacking method used your photographs are now ready for ‘Dual Masking.’ 

 

 

 

 

 

 

 

 

 

Figure 59- Review outputs for retouching. 
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CHAPTER 15 

DUAL MASKING 

The goal is to create textures with fine details on all surfaces without any textural 

distortion, regardless of their complexity. A dual masking technique is being used as an 

innovative method to achieve this goal with consistency, even at high magnifications. Instead of 

manually masking each image in Metashape, which would be time-consuming, this technique 

utilizes Photoshop's capability of identifying the in-focus area to automate the process. The first 

step involves creating a reference mask to eliminate background elements that could interfere 

with Metashape's alignment algorithms. The second step involves creating a focus-selected mask 

that only includes the pixels within a defined radius of the in-focus area of an image. This ensures 

consistent focus quality in the final texture while still allowing the rest of the image to aid in the 

alignment process.  

 

Create a ‘Reference Mask’ 

• Open Photoshop. 

• Open a Stacked image. 

• Create a new action (Figure 60). 

o Windows -> Action -> Create New Action 

o Name the action ‘Dual Mask’ and click Record. 

▪ Every executable task performed during recording will be saved and later 

applied in a batch process.  

• If Helicon Focus was used: 

o Go to Image -> Canvas Size 
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o Input the images original pixel resolution and click OK. 

▪ Helicon Focus automatically trims the product image to the maximum 

resolution where every pixel has data, after transforming for focal 

breathing. 

▪ This leaves your images with different resolutions, which Metashape 

does work well when this happens. 

▪ Find an image where both the width and height are slightly different from 

the original resolution (e.g., 5988 x 3950 instead of 6000 x 4000). 

▪ Change the Canvas size (not the image size, as this can cause 

unwanted transformations) to a standardized resolution. 

▪ This step can also be done if multiple cameras with different resolutions 

are used.  

o If Helicon Focus was not used skip to the next step. 

• Select the subject (Figure 61, top).  

Figure 60- Creating an action. 
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o Photoshop excels at 

selecting the object if the 

entire object is visible in 

the image. However, if the 

object is zoomed in too 

closely, the selection may 

not be accurate, leading 

to problems.  

o If there are images that 

are zoomed in too closely 

or have objects that are 

too large and the edges of 

the object are not visible, 

separate those files from 

the batch that will be 

processed with this 

action. 

o Process these files in a 

separate batch using an action that does not include the ‘Select Subject’ function. 

• Select -> Inverse (Figure 61 middle) 

o Now everything except the object is selected. 

• Hit the delete key -> OK (Figure 61, middle) 

o The background will no longer confuse Metashape during the alignment process!  

 

Create ‘Focus Masks’ 

To be continued directly after the last step for ‘Reference Mask’ creation: 

Create a mask for each image in the set, based on the depth of field or focus within that 

image. By masking the out-of-focus and blurry areas, you isolate the parts of the image that are in 

Figure 61- Selecting subject. 
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focus and sharp. This approach is especially beneficial because it permits the full image to be 

used in mesh creation, while preserving the highest quality part of the image for constructing the 

texture that will overlay the mesh. Without this step, achieving the desired high-resolution texture 

becomes a much more challenging task. 

• Select -> Focus Area (Figure 61, bottom). 

o Ensure the ‘Preview’ option is selected. 

o Once a radius is chosen, hit OK. 

▪ The Focus Area parameters automatically determine an In-Focus Range 

value. While it can be left on Auto, manual adjustment to find a value that 

works best for the conditions of the collected data set is recommended. 

Higher numbers include a larger radius from the most in-focus areas, 

while lower numbers select a smaller radius from the most in-focus 

portions. Values between 0.5-1.5 are generally effective (Figure 62).  

• While the Focus Area is still selected, go back to Select -> Save Selection -> OK (Figure 

63).  

Figure 62- Creation of an Alpha Channel. 
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o An Alpha Channel has been 

created, covering everything 

except the in-focus area. This 

channel will only be utilized by 

Metashape when instructed to 

do so. 

Figure 63- Focus area settings. 

Figure 64- Save settings. 

Figure 65- Compression settings. 



  88 

• File -> Save As -> TIFF format with the Alpha Channel option selected, choose either 

LZW or ZIP compression, then click OK (Figure 65).  

o To use the Alpha Channel created in the previous steps, you must select a file 

type that supports Alpha Channels. TIFF is a recommended option as it is 

consistent, but JPEG 2000 is another alternative. 

o If TIFF is selected it is recommended that you use LZW compression. Faster file 

creation, larger file size. ZIP compression has a much slower creation time, 

smaller file size. 

• Stop recording the action.  

o Make sure that the action is no longer recording, as the next step is only to be 

done once for each camera resolution used. 

• Create background image to be the matching ‘Reference Background’ for all other photos 

by Select -> All 

• Hit the delete key and confirm. 

o You will be left with a white canvas, which is the desired outcome. 

• Go to File -> Save As. 

• Save the file as a regular JPEG. 

o Name it something like ‘RefBkg’  

• Save it in the ‘Main Folder’ or a location where it will be easily accessible for each model 

created. 

o If prompted with a warning to "Save changes to...", choose "No". 

• Close the file. 

• Apply the ‘Dual Mask’ action to all the 200-400 stacked images through a batch action. 

o Note: If there are images that are too closely zoomed in on the object and don't 

have a surrounding background, separate these images into a different folder 

and process them using a different action that omits the 'Select -> Subject' step. 

v 
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• To run the batch process, go to File -> Automate -> Batch (Figure 66).  

o Action: Choose the Dual Mask action. 

o Source: Choose the folder 

containing the image. 

Choose the object’s ‘2-

Stacked’ folder. 

o Log Errors to File: Create 

a text (.txt) file. 

o Destination: Folder. 

Choose the object's ‘3-

Focused’ folder. 

o Check ‘Override Action 

‘Save As’ Commands’ 

o Assign a file naming 

schema. 

o Hit OK and let the process run, applying the Dual Mask to each file. 

Figure 66- Batch processing. 

Figure 67- Focused masked TIFFs in file explorer. 
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• Your files are now ready to be imported into Metashape! The alpha channels will cause 

the thumbnails to appear as shown on the right side of the File Explorer (Figure 67), but 

all the data is still present and will be visible in Metashape. 
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CHAPTER 16 

AGISOFT METASHAPE 

Agisoft Metashape, formerly known as PhotoScan, is a photogrammetry software used to 

create 3-Dimensional models from a series of 2-Dimensional images, as discussed in the 

Structure-from-Motion section. 

The Metashape User Manual v1.6 provides detailed explanations for various functions 

that are useful but not commonly used. These functions, such as Lens Calibration, Automated 

Excessive Image Elimination, Video Data Processing, Multi-chunk Alignment, Resizing Bounding 

Boxes, and Importing External Point Clouds, are not covered in this guide but it is recommended 

to review the manual for instructions on these topics. 

 The performance of Metashape's processes is dependent on both the system hardware 

and the settings used. The specifications of your workstation will impact the settings that can be 

used. The exact workflow process may vary based on the settings, system hardware, and the 

data set being processed. 
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Workflow Stage Procesor Relative Time 
Burden 

‘Time remaining’ 
estimate 

Load Photos CPU Low N/A 

Masks CPU Low to 
Intermediate 

Accurate 

Align 
Photos 

Detecting Points GPU Low to 
Intermediate 

Accurate 

Selecting Pairs GPU Low Accurate 

Matching Points GPU Low to 
Intermediate 

Accurate 

Estimating 
Camera 
Location 

CPU Intermediate Typically too high. 
Initial estimated time 
left often order of 
magnitue too high (Ex: 
3 hours is often 3 
minutes)  

Optimizin
g Camera 
Locations 

Reconstruction 
Uncerntainty 

CPU Very Low Accurate 

Reproduction 
Error 

CPU Very Low Accurate 

Projection 
Accuracy 

CPU Very Low Accurate 

Build 
Dense 
Cloud 

Depth Map 
generation 

GPU Low to 
Intermediate 

Accurate 

Dense Point 
Cloud 
generation 

CPU High Typically too low.  Real 
time could be 5+ 
longer than estimated 

Color 
generation 

CPU Very Low Accurate 

Build 
Mesh 

Building Model CPU and 
GPU 

Intermediate Typically too high. 
Processing time is 
often 1/2 to 1/3rd  of 
value reported 

Build 
Texture 

Paramerterizing 
Texture Atlas 

CPU Low Accurate to slightly 
too high 

Blending 
Textures 

GPU Low to 
Intermediate 

 

Table 7- Workflow stage, process type, and estimated times. 
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Network Processing 

The amount of time it takes to 

complete a model in Metashape grows 

exponentially as the number of 

photographs in the data set grows. To 

handle large projects efficiently, it is 

recommended to use a high-performance 

computer. Another option is to use remote computing through Metashape's local or cloud-based 

network processing, which can significantly reduce processing time by distributing tasks across 

multiple nodes. Please refer to pages 129-136 in the Metashape User Manual v1.6 for more 

information on this feature.  

 

Navigation and Set up  

It is recommended to take the 

time to familiarize yourself with the 

Metashape application and experiment 

with various tools. This guide will only 

highlight commonly used or referenced 

locations, as comprehensive navigation 

guides are already available. 

• When ready, go to the toolbar at 

the top of the page. 

• Select Tools -> Preferences.  

• On the General tab, edit the 

settings as you see fit. 

o You can choose between 

the Dark Theme or High 

DPI mode. 

Figure 68- Diagram from Metashape User Manual 
1.6 (pg. 129) 

Figure 69- Metashape scales very well in multi-GPU 
systems and is unloading increasing amounts of 
processing burden on the GPU. 
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• Click on the GPU tab  and select all physical GPUs, but make sure that ‘Use CPU when 

performing GPU-accelerated tasks’ is not selected. No other preference changes are 

necessary (Figure 69).  

 

Adding Photographs and Saving Projects 

• To import TIFF files from the appropriate ‘3- Focused’ files into Metashape:  

o Click on the files in the file explorer and drag them directly into the "Photos" pane 

(Figure 70, top) 

o Add photos through the Toolbar -> Workflow (Figure 70, bottom left) 

Figure 70- Methods for Importing files into Metashape. 
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o Add photos to the workspace by right-clicking on ‘Chunk 1’ and selecting ‘Add’ 

(Figure 70, bottom right). 

o If you receive the error message seen in Figure 71, you can just hit OK and 

ignore it. 

o Note: All photographs 

are in the same 

chunk. It is possible to 

render different photo 

series from the same shoot into different point clouds and then merge them later, 

but with the workflow used so far, it is not necessary. 

o To name the new project file, select File -> Save. 

o It is important to save often, as in case the program crashes, all work will be lost 

and there is no way to recover the data. Therefore, it is advisable to save the 

project frequently. 

o Choose a project name that is consistent with the previous schema and save it in 

the appropriate 'Master Folder'.  

o Import Reference Mask 

o One method for importing 

masks into Metashape is 

File -> Import -> Import 

Masks 

o Select the reference mask 

for the first set of images 

and click Open.  

o The masks will be 

imported and applied to the corresponding images in the Photos pane. Note that 

the masks are used to guide the alignment process in Metashape and will not be 

present in the final 3D model.  

Figure 71- Error message. 

Figure 72- Importing reference masks. 
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o Repeat the process for all remaining sets of images in the project. 

o After importing all reference masks, you can now proceed with the alignment 

process. 

o If you do not see the jpg file, don't worry, just select the folder where the file is 

located and select import. 

o If you encounter any red lines of code in the details box during this stage, it is 

likely that the resizing of the canvas action in Photoshop did not work correctly on 

the images that generated the error. 

▪ Either reprocess those images or eliminate them from the data set in the 

Chunk.  

o This is one of the reasons Metashape stresses not to do image preprocessing in 

their manual: ‘Metashape operates with the original images. So do not crop or 

geometrically transform, i.e., resize or rotate, the images. Metashape can 

process only unmodified photos as they were taken by a digital photo camera. 

Processing the photos which were manually cropped or geometrically warped is 

likely to fail or to produce highly inaccurate results. Photometric modifications do 

not affect reconstruction results.’ 

▪ This statement may read as alarmist. A more accurate statement might 

be "Be cautious when doing these tasks and make sure you know what 

you're doing." 

Figure 73- Importing masks as indicated (left) will cause the background for each image (grayed 
out, right) to be completely masked out and those pixels will not be used during the alignment 
process.  
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• To verify that all your photos have been masked properly, go to the Photo pane, and 

select Show Masks.  

o The images will then be displayed as black and white thumbnails showing the 

masked regions. 

o Observe that one of the images in the dataset in figure 74 is labeled as "No 

Mask." This issue may have arisen due to corruption during the saving process 

or during the transfer to a new hard drive. To fix this, remove the corrupted 

image, locate its uncorrupted version in the "1-Stacked" folder, and mask it in 

Photoshop using the steps outlined previously. Finally, upload the correctly 

masked "Focused" version back into Metashape.  

• To minimize manual masking, it is best to follow the prescribed steps in the workflow. 

However, if necessary, manual masking can be performed within Metashape, but it is 

time-consuming.  

o For directions on manual masking, see the "Build Texture" section. 

 

Generate Sparse Cloud  

The sparse cloud is a preliminary stage in the photogrammetry process. It represents the 

initial attempt at locating correlated points from each image in 3D space. It should be seen as a 

Figure 74- Masked photos in the Photo Pane. 



  98 

rough approximation of the scene's geometry and used as a calibration tool to get the parameters 

correct before proceeding to a more detailed representation. 

• Go ahead and save again. It is strongly recommended to save frequently between steps. 

• Select Workflow -> Align Photos and choose the appropriate settings (Figure 75). 

• Recommended Settings: 

o Accuracy: Medium 

▪ Some believe that the highest quality alignment settings should be used 

whenever possible. However, an initial alignment with medium accuracy 

is typically sufficient as every increase in resolution exponentially 

increases the processing time. 

▪ Highest means that 

the image resolution 

is upscaled by a 

factor of 4. 

▪ High is the images 

original quality.  

▪ Medium is 

downscaled by a 

factor of 4. 

▪ Low is downscaled by 

a factor of 16. 

▪ Lowest is downscaled 

by an additional factor of 4. 

o Key point limit: >10,000 

▪ It has been reported that there is a decrease in results above ~10,000 

key points, however, most experienced users prefer to stay above 

40,000. If your computer has processing power, it is easy to remove low 

confidence points later. 

Figure 75- Alignment settings. 
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o Tie point limit: 0 (infinite)  

• Check the box for ‘Adaptive Camera Model Fitting' and select OK 

• If the photo coverage or quality is inadequate, some photos may not align properly.  

o The warning seen in figure 76 will appear if one or more of your photos were not 

able to find 3 or more Tie Points.  

▪ Photos which did not align will not have a checkmark by them in the 

Photos Pane or will have the letters ‘NC’ by them in the Workspace 

Pane. 

o Depending on the significance of the photo(s) to the final output, you have 

several options:  

▪ (1) reset and re-run the alignment process, 

▪ (2) delete and reshoot the photo, 

▪ (3) add photos with better overlap, 

▪ or (4) delete the photo completely.  

• Typically, it is acceptable if a few photos do not align. In such cases, you can simply 

delete them and move on. However, if the number of cameras that did not align or are 

obviously misaligned is significant or critical to the project, you can apply the following 

iterative "re-set and re-run" steps: 

o Select any cameras that are obviously misaligned. 

▪ Right-click on them -> Reset Camera Alignment. 

o Align photos again, but at a higher quality and/or with an estimated reference 

pre-selection.  

Figure 76- Photo unable to align. 
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o Make sure to deselect "Reset current alignment," or all correctly aligned photos 

will reset their key points as well. 

o Repeat the process as needed. 

• If the number of photos that can be accurately aligned is still not satisfactory and 

obtaining reshoots or additional photos with better overlap is not possible, then as an 

absolute last resort, photos may undergo manual alignment.  

• This requires placing markers manually on already aligned images and then placing 

those same markers on the images that were not aligned.  

o This is incredibly time-consuming, works less often than not, and can lead to 

unsatisfactory results. 

o Performing this manual alignment will not be needed if photos were acquired and 

processed as previously outlined.  

o However, if desired, a more detailed exploration into manual alignment with 

markers can be viewed in this video 

(https://www.youtube.com/watch?v=Uny9nTr22go) by Brittany Johnson. 

• After completing the process of aligning your photographs, examine the camera positions 

and the sparse point cloud.  

Figure 77-Toggling Cameras on and off to view Sparse Cloud.  

https://www.youtube.com/watch?v=Uny9nTr22go
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o Toggle the blue camera locations on and off by selecting the camera icon in the 

toolbar. Notice that the sparse cloud has extraneous key points which will need 

to be removed (Figure 77). 

o If the point cloud is not visible after aligning the cameras, try this tip: right-click on 

a camera in the Photos pane and select "Look Through".  

o Additionally, while navigating in the Model Pane, it may be helpful to change the 

rotation anchor point. To do this, right-click a point on the model and select 

'Center View'." 

 

Optimize Camera Locations 

Recall that the Sparse Cloud should be seen as a rough approximation, by optimizing the 

camera locations you ensure that you will improve the accuracy of your model, lower the 

processing time, and achieve an overall better model by reducing artifacts.  

• To improve camera alignment accuracy, use only tie points with high confidence 

intervals. 

• Follow these steps to eliminate low-confidence tie points: 

o Select the Tie Points layer in the Workspace Tab. 

o Apply selection criteria for reconstruction uncertainty, reprojection error, and 

projection accuracy (specific guidance will follow, but you may need to iterate to 

find the best settings for your project). 

o Delete selected tie points. 

o Click on Optimize Cameras Alignment from the Reference Pane (this ->  ) to 

realign cameras to the remaining Tie Points. 

o Repeat the process until only high-confidence tie points remain. 

• Repeat all steps until thresholds are met (this may take 2-3 or more iterations). 

• If necessary, manually select and delete points that are clearly out of alignment using the 

manual selection tool on the toolbar (  ). 
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• During testing, it is typical to delete 50-90% of the original tie points. Repeat the selection 

criteria, deletion of points, and optimization of cameras until nearly no tie points are 

selected for each stage. 

• Note that cameras may be reset during this process, but this is okay if the suggested 

photo density steps have been followed. 

 

Reconstruction Uncertainty  

You can select points by the amount of error or uncertainty calculated for each point. 

These are typically caused by camera noise, inconsistent lighting conditions, or other 

inconsistencies. 

• In the Workspace Tab, select Model and choose Gradual Selection from the drop-down 

menu.  

• Choose the criterion of 

"Reconstruction Uncertainty" and set 

the level to around 5-10 for hand 

samples or 15-30 for outcrops (the 

optimal level depends on photo 

density, overlap, and image quality, 

Figure 78).  

• Click OK. 

• Delete the selected points by pressing the 

delete key (it is common for the entire sparse 

cloud to appear highlighted in pink, Figure 

79). 

• In the Reference Pane, go to the top and 

select Optimize Camera Alignment. 

• Check the box for Adaptive Camera Model Fitting and click OK. 

Figure 78-Gradual Selection. 

Figure 79- Selected Tie Points in pink. 
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Reproduction Error 

• In the Workspace Tab, select Model and choose Gradual Selection. 

• Choose the criterion of Reproduction Error and set the level to around 0.5. 

• Click OK. 

• Delete the selected points by pressing the delete key. 

• In the Reference Pane, go to the top and select Optimize Camera Alignment. 

• Check the box for Adaptive Camera Model Fitting and click OK. 

 

Projection Accuracy 

• In the Workspace Tab, select "Model" and choose "Gradual Selection" 

• Choose the criterion of "Projection Accuracy" and set the level to around 7-10 

• Click "OK" 

• Delete the selected points by pressing the delete key 

• In the Reference Pane, go to the top and select "Optimize Camera Alignment" 

• Check the box for "Adaptive Camera Model Fitting" and click "OK" 

 

Scale and Reframe Object 

• Scale the model manually using markers, such as a printed scale bar, ruler, or yardstick, 

that are visible in at least two photographs of one set. 

• Find a few images with the reference scale in them and place markers at both ends of the 

reference scale (Figure 80, left). Repeat this process for more than two images. 

• In the Reference Tab, select the two markers and create a scale bar by recording the 

distance in meters between the two points (Figure 80, right).  
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o Note: The creation of scale bars in Metashape is important for those doing 

quantitative work, such as building DEMs. However, for those creating models, a 

scale bar will be superimposed directly onto the model, so this step is not critical. 

• Reframe the model if necessary: 

o Metashape will attempt to calculate the bounding frame dimensions and location, 

but refinement may be required. 

o Use the Resize Region and Rotate Region tools from the toolbar to resize and 

rotate the bounding frame as desired.  

 

Build Dense Cloud 

• A note on Building Meshes in Metashape: 

o A polygonal mesh or model can be constructed from point cloud or depth map 

data. 

o Building a mesh directly from depth maps alone bypasses the Build Dense Cloud 

stage, which is tempting because it is often the longest stage to complete. 

o However, skipping this stage can lead to lower quality results and a lack of ability 

to clean up the data before building the mesh. 

Figure 80- Adding Markers and Creating Scale Bars in Metashape. 
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o If the project calls for the creation of a DEM, building the mesh from the dense 

cloud data is preferred as the "Inverse Distance Weighting" interpolation method 

used by the dense cloud method is generally considered superior to the 

"Triangulated Irregular Network" interpolated mesh method.  

o Experiment to determine what works best for your project. 

• Building the Dense Cloud: 

o Select Workflow from the toolbar and choose Build Dense Cloud. 

o Choose a desired quality level, starting with low or medium to check for 

alignment issues before reprocessing at higher levels. 

o Set Depth Filtering to Aggressive. 

o Check the boxes for Calculate Point Colors and Calculate Point Confidence. 

o Wait for the process to complete. You can use this time to do something else, 

such as watching a movie. 

 

Edit Dense Point Cloud 

Every Dense Cloud will have points created from ‘noise.’ These artifacts can come from 

several sources, including: 

• Areas not masked properly. 

• Shadows on the underside of the object. One of the reasons is that proper lighting is 

critical. 

• Certain image artifacts, such as those generated by lens distortion of camera motion. 

It is important to remove noise points which will negatively impact the quality of the 

model. By using the techniques outlined, you can effectively eliminate noise points and produce a 

high-quality 3D model. 

• Ensure the Dense Cloud layer is selected in Metashape. 

• Manually delete easily selectable noise points by pressing the delete key on your 

keyboard. 
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• Use the Filter by Confidence tool to remove remaining noise points: 

o The Filter by Confidence tool can be found under Tools in Metashape, and then 

Dense Cloud. 

o The tool works by filtering out points based on their confidence level, with higher 

numbers indicating more confident points. 

o Start with Min: 0 and Max: 1, and manually delete any remaining noise points on 

your screen. 

o Reset the values by setting Min: 0 and Max: 255 and check the remaining points. 

o If there are still noise points present, increase the Max value to 2, then 3, 4, etc. 

until you are satisfied with the results. 

o You can use the Dense Cloud Confidence View from the toolbar to determine the 

value needed to eliminate errant points. Notice that a value of 3-4 on the model 

in figure 82 will eliminate all undesired points and leave plenty of high-confidence 

points to build the mesh from. 

Figure 81- Filtering Points by Confidence. 

Figure 82-Dense Cloud Confidence View. 
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o If necessary, use the tool for selecting points based on other criteria such as 

color or classification to delete additional noise points.  

 

Build Mesh 

• Go to Workflow in Metashape and select Build Mesh. 

• Choose the desired settings, using the example settings in Figure 83 as a guide. 

o If exporting the model to SketchFab, select a face count of less than 2,000,000.  

o If rendering an outcrop model, set the face count to around 4,000,000 initially. 

This is because outcrop edges often have lower photo density and may need to 

be cropped out. 

▪ After cropping has occurred, the face count can be decimated to exactly 

2,000,000 if needed. 

• Hit OK.  

Note: Although the Dense Cloud workflow is more time-consuming, it is generally 

recommended over the Depth Maps workflow. 

 

Figure 83- Settings for Depth Map (left) and Dense Cloud (right) reconstructions at medium 
quality and face count. 
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Edit Mesh 

Steps to finalize the mesh in 

Metashape:  

• Remove any disconnected 

artifacts (i.e. “shrapnel") from the 

edges of the model manually 

(Figure 84.)  

• Use the Gradual Selection tool to 

remove any remaining disconnected pieces of mesh from the main body of the model: 

o Select Model -> Gradual Selection in Metashape 

o Set the Criterion to "Connected component size" and adjust the slider level until 

satisfied (typically set to 99) 

o Hit OK and delete all selected faces with the delete key 

• Remove further unwanted sections from the model prior to finalizing it by manually 

trimming faces. 

o Select Model -> Manual Selection  

o Select any unwanted faces that are connected to the main model, typically 

around the edges of the model and delete them.  

Figure 84- Example of disconnected artifacts (i.e. 
"shrapnel"). 

Figure 85- Gradual Selection (right), Manual Selection (middle), and final model boundaries 
(right). 
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• Close any holes in the model using the Close Holes tool under Tools in the toolbar (Mesh 

-> Close Holes). Adjust the slider until the holes are closed.  

• Decimate the model to a 

desired face count (less than 

2,000,000 faces) using the 

Decimate tool under Tools -> 

Mesh -> Decimate in 

Metashape. 

Note: SketchFab, the chosen 

3D file hosting website may have 

limits, such as a 200 MB upload 

limit for both model and texture 

files. To consistently create 

models that are smaller than that, meshes should have fewer than 2,000,000 faces.  

 

Build Texture 

Metashape is designed to create a single output mosaic image from all unmasked 

portions of an image. During this process, Metashape estimates the image quality of each portion 

and determines which portions to use. However, the algorithm used for this process by 

Metashape is not always the most effective. To improve the image quality and resolution of the 

final model, it is recommended to create a secondary mask using Photoshop's in-focus detection 

algorithm. This algorithm is more effective in determining which portions of the images should be 

used, and thus leads to a higher quality and more resolved final mosaic image.  

 

Import Focus Masks 

Steps to import masks in Metashape: 

• Right-click on any photograph in the Photos Pane. 

• Go to Import -> Import masks (Figure 87). 

Figure 86- Closing Holes in Mesh. 
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o Method: From Alpha Chanel 

o Operation: Replacement 

o Apply to all cameras. 

• Select Show Masks in the Photo pane (Figure 87). 

• Scroll through the masks quickly to ensure that no images are missing their mask. 

• If all masks are present, proceed to create the texture.  

 

Build In-Focus Texture 

Steps to build the texture in Metashape:  

• Go to Workflow in Metashape and 

select Build Texture.  

• Choose the desired settings (figure 

88). 

o Note: The texture size and 

count may need to be 

adjusted based on project 

needs. The first value is the 

resolution of the JPG file (for 

example, 8192 x 8192) and 

Figure 87- Masks created from Alpha Channels. 

Figure 88- Preferred setting for hand samples. 
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the second is the number of texture files of that resolution to be generated for the 

total surface area of the model. 

o It is not recommended to go beyond 12 textures of 4096 x 4096 resolution. 

Typically, one texture of 8192 x 8192 resolution or four textures of 4096 x 4096 

resolution is sufficient but adjust as needed. 

o If more textures are desired, reduce the face count of the model before 

generating the new texture to keep the total size of the model and file being 

generated under 200 MB. 

• Generate the texture according to the chosen settings. 

 

Edit Masks 

Steps for refining the texture in Metashape: 

• Render the texture for the first time. This process is known as "parametrizing the texture." 

Note that this step will only need to be done once unless the texture size or count is 

changed. 

• Review the generated texture. Even though Photoshop's in-focus detection algorithm is 

effective, there may be areas on the model that do not look correct. 

• To refine these areas, use the selection tool on the region in question and right-click. 

Select Filter Photos by Point. 

• In the Photo Pane, the images will be filtered. Each of the remaining images should 

correspond to the selected portion of the model. 

• Edit the portion of the source photos to be included in the blending process. Use the 

selection tool and add (Ctrl + Shift + A) or subtract (Ctrl + Shift + S) from the masks. 

• Repeat these steps as needed to refine the texture until you are satisfied with the results. 

• Once the texture is refined, blend the textures together. Note that this step will be quicker 

than the initial parametrizing step, as it only requires blending the textures, not 

parametrizing them. 
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Additional Texture Edits 

Steps for editing the texture file in Photoshop (or photo editing software of choice): 

• Perform any desired editing to the generated texture, such as: 

o Color matching to a color standard 

o Adding swatches from the reconstructed scene 

o Increasing vibrance, sharpening, etc. 

o Adding annotations, labels, contour lines, or segmentation 

o Reducing shadows 

o Making manual corrections 

• Export the texture from Metashape. 

o Go to File in Metashape and select Export. 

o Select Export Texture. 

o Name the file, select the file type, and save location. 

• Open the exported image file in Photoshop. 

o Locate any errors in the texture (figure 89). 

o Use the Lasso tool (L) to select the area around the error. 

Figure 89- Small error highlighted in red. Error in Metashape file (left). Error in Photoshop file 
(right). 



  113 

o Select the Patch Tool (J) or the Clone Stamp tool (S) to correct them (figure 90).  

▪ If there are small errors along the edges (Figure 89), these can detract 

from the realism of the texture. While fixing these errors in Metashape 

can be time-consuming, a quicker approach is to manually edit them in 

Photoshop.  

o Make any desired 

general adjustments 

to the texture, such 

as adjusting the 

brightness and 

contrast (figure 91). 

This will help to 

ensure that the 

texture visually 

matches the hand 

sample.  

o Add any desired figures, such as scale bars or school symbols (Figure 92). Scale 

bars can help students with quantitative descriptions and analysis. 

o Create a new layer in the texture file and copy the image file to the new layer. 

Figure 90-Process for removing errors shown with above steps. 

Figure 91- Edit general adjustments through Camera 
RAW Filter (ctrl+shift+A) 
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o Edit and orient the new layer as desired. When satisfied, flatten the image and 

save it.  

▪ Image -> Flatten Image -> Save. 

• Check the updated texture file draped on the model in Metashape. 

o Import the updated texture file back into Metashape by going to File -> Import -> 

Import Texture.  

• If satisfied, the model is now ready for export to SketchFab. 

 

Build DEM and Orthophotos 

The creation of Digital Elevation Models (DEMs) using Agisoft Metashape is a foundational 

aspect of the software, but will not be covered in this guide as it is not relevant to the outlined 

approach. The creation of orthorectified images will not be covered in detail, but if you want a 2D 

image of your 3D model from a specific angle, follow these steps: 

• Steps for orienting the "front" face of your model for Orthomosaic creation in Metashape: 

o Go to Top View by hitting numpad 7.  

Figure 92- Graphical features added to the model. 

Figure 93- Model with example scale bars and school logo 
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o Use the rotate object tool (in red below) to rotate the model to your desired "top" 

view.  

o Return to normal navigation mode by hitting the space bar. 

o Go to front view by hitting numpad 1. 

o Fine-tune the rotation of the model to your desired "front" view by switching back 

to rotate object mode using the space bar. 

o Return to normal navigation mode using the space bar. 

o Go to side view by hitting numpad 3. 

o Fine-tune the rotation of the model as needed by switching back to rotate object 

mode using the space bar. 

o Return to normal navigation mode using the space bar. 

o Check the alignment of the model by going through the views in sequence 

(numpad 7, 1, and 3) and repeat the steps as necessary. 

Note: A more detailed beginner-level tutorial for Orthomosaic creation in Metashape can be found 

at https://www.agisoft.com/pdf/PS_1.3%20-Tutorial%20(BL)%20-

%20Orthophoto,%20DEM%20(GCPs).pdf. 

 

Batch Processing  

Batch processing in Agisoft Metashape allows users to process multiple projects at once, 

reducing the time spent on repetitive tasks by automating them. There are two main forms of 

batch processing for creating a 3D model: the native version within Metashape, and a Python-

based version.  

 

 

 

 

https://www.agisoft.com/pdf/PS_1.3%20-Tutorial%20(BL)%20-%20Orthophoto,%20DEM%20(GCPs).pdf.
https://www.agisoft.com/pdf/PS_1.3%20-Tutorial%20(BL)%20-%20Orthophoto,%20DEM%20(GCPs).pdf.
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Native Batch Processing  

Steps to use the Batch Process tool in Metashape: 

• Load as many projects into separate 

chunks as desired.  

• Go to Workflow -> Batch Process. 

• Select the Job Type, chunks to apply 

the job, and desired settings (Figure 

94). 

• Click OK. 

• To add additional jobs, click on 

"Add..." and repeat the steps above. 

• Check the "Save project after each 

step" option and click OK to start the 

batch process. 

Note: The Batch Process tool in Metashape is only partially useful, as many steps in the 

workflow, such as cleaning up point clouds, require human intervention and there is no relevant 

Job Type available. 

 

Python Script Batch Processing 

Metashape is built to run with python scripts, which can be used to automate the iterative 

stages in the workflow with minimal human intervention. 

• Writing a script for Metashape is relatively straightforward using Metashape's guide 

(https://www.agisoft.com/pdf/metashape_python_api_1_6_5.pdf). 

• If you are not comfortable writing a Python script, a tool has been created by users from 

UCDavis that requires no coding experience. 

Figure 94 -Batch processing by Job Type and 
chunks. 

https://www.agisoft.com/pdf/metashape_python_api_1_6_5.pdf
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• This tool allows for the creation of easy to run, reproducible, automated, and documented 

Metashape photogrammetry workflows in batch on individual computers or as parallel 

jobs on a computer cluster. 

• The GitHub for this tool can be found online (https://github.com/ucdavis/metashape). 

• To use this tool, Python (Anaconda preferred) and R must be installed on your system. 

https://github.com/ucdavis/metashape
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CHAPTER 17 

SKETCHFAB 

SketchFab is a web-based platform for hosting 3D models. It enables creators to publish 

their content online for a public or private audience, making it an essential tool for educators to 

provide easy access to students with web-enabled devices.  

Steps to upload a finished model to SketchFab: 

• Uploading via Metashape: 

o Go to File in Metashape and select 

Upload Data.  

o Choose the model as the source data 

and give it a name and title. 

o Link your SketchFab account to 

Metashape by inserting your API key 

and password. 

• Manual Upload: 

o Go to File in Metashape and select 

Export, then Export Model. 

o Name the OBJ file and select a 

location, then save it as a JPEG to 

keep the file size down.  

o Three types of files will be 

produced: texture file(s), texture 

atlas, and mesh file.  

▪ Note: The number of texture files will vary depending on the ‘Build 

Texture’ settings chosen. 

o Navigate to SketchFab.com and log in. 

Figure 95- Uploading via Metashape. 

Figure 8-Files exported. 
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o Select upload ( ) and drag and drop all files created during the Export 

Model process. 

o Title and describe the file, assign categories and tags, and make the file public or 

private. Choose if the file can be downloaded by the public. 

• Use the 3D settings to adjust the appearance of the model. 

o General settings: 

o Select Straighten Model then Show Advanced Rotation to set the X, Y, and Z of 

the model. Also, set the floor of the model, which cannot be rotated around. 

o Select Save View to set the orientation the model will be shown at as a thumbnail 

and on initial loading. 

• Materials settings: 

o Experiment to find the desired settings for each texture file. 

o Select the texture file from the drop-down menu and apply desired settings. 

o Repeat for each file. 

• Annotation: 

o Use the annotation tool to select a feature of interest, give it a title and 

description, and include links to HD still images. 

o Select Use the current POV ( ) function to automatically rotate the model to 

the orientation defined when a student clicks on the annotation. 

• Publish the model! 
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CHAPTER 18 

RESULTS AND DISCUSSION 

The author of this thesis has created a comprehensive repository on SketchFab featuring 

over a hundred 3D models of minerals, rocks, and outcrops. These models are being utilized for 

post-secondary geoscience education and have attracted attention from the online community, 

amassing thousands of views to date. The goal of this free online collection is to serve as a 

pedagogical tool for any educator or student to use. 

The creation of high-resolution 3D models with sub-millimeter textures is a demanding 

task, but this guide offers a methodology to achieve consistent results. These models are being 

employed to transform the teaching methodologies at Arizona State University's School of Earth 

and Space Exploration. As the models are enriched with annotations, text, and audio files, they 

will continue to evolve into more pedagogically useful supplementary materials. The shift towards 

providing students with digital resources, accessible online at any time, is a crucial step in the 

direction of differentiated instruction. This approach not only allows for students to view 

specimens and outcrops multiple times, but also incorporates the models as an essential 

component of the ongoing teaching and learning process. 
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CHAPTER 19 

CONCLUSIONS 

The use of 3D models is becoming increasingly common and important in both scientific 

research and education. By constructing these models, knowledge can be added to physical 

objects and shared with a wider audience, providing repeated access even if in-person viewing is 

not possible. Platforms like SketchFab offer numerous opportunities for virtual field trips, 

annotated guidance, and repeated access to the models. At the School of Earth and Space 

Science (SESE), these models have also been utilized for assessment purposes. 

Geoscience educators should strive to showcase the scientific process in multiple forms 

and the use of 3D models is one such way to do so. Whether through the use of these methods 

or alternative options, we recommend incorporating 3D models into supplemental instruction or 

assessment for maximum impact and effectiveness. 
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